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1.0 Introduction 

 

1.1 Copyright 

 
 

ECD 
World Headquarters 

Electronic Controls Design, Inc. 
4287B S.E. International Way 

Milwaukie, Oregon 97222-8825 U.S.A. 
Telephone: +(1) 800.323.4548 

+(1) 503.659.6100 
FAX: +(1) 503.659.4422 

Technical Support: +(1) 800.323.4548 
Email: ecd@ecd.com 

Internet: http://www.ecd.com 
 

Asia/China 
ECD Asia/Pacific 

Covent Garden Post Office 
P.O. Box 093, Singapore 911634 

Telephone: +(65) 9.692.6822 
FAX: +(65) 6.241.9890 

Email: ecd.asia@ecd.com 
 

Europe 
ECD 

4287B S.E. International Way 
Milwaukie, Oregon 97222-8825 U.S.A. 

Telephone: +(1) 503.353.6250 
FAX: +(1) 503.659.4422 

Email: ecd.europe@ecd.com 
 
Copyright ©2002-2010 ECD. All Rights Reserved. Printed in USA. US Products of ECD are covered by foreign and US Patents and Patents Pending. Information in this 
publication supersedes all previously published information. This Publication may not be translated and/or reproduced or stored in data retrieval system, or transmitted in any 
form or by any means without the express written permission of ECD. Specification and price change privileges reserved.  
 
The trapezoidal ECD logo®, OvenWATCH®, <%PRODUCT1%>, <%PRODUCT2%> and M.O.L.E.® (Multi-Channel Occurrent Logger Evaluator) are registered trademarks of 
ECD. MS-DOS and Windows are registered trademarks of Microsoft Corporation. IBM, IBM PC and PS/2 are registered trademarks of International Business Machines 
Corporation. 
 
While every precaution has been taken in the preparation of this document, ECD assumes no responsibility for errors or omissions, or for damages resulting from the use of 
information contained in this document or from the use of programs and source code that may accompany it. In no event shall ECD be liable for any loss of profit or any other 
commercial damage caused or alleged to have been caused directly or indirectly by this document. 
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1.2 Declaration of Conformity 

 

Electronic Controls Design, Inc. 

 
4287-B S.E. International Way 
Milwaukie, Oregon U.S.A. 97222-8825 
(503) 659-6100 / (800) 323-4548 
FAX: (503) 659-4422 

 

Declaration of Conformity 
 
Product: "Xpert Ready" SMG W/PP Part number: E40-2875-40 

 "Xpert Ready" SMG W/PP (RoHS)  E45-7647-40 
 OvenWATCH® Station  E41-6928-42 

 
 

The above product is in conformity with the following standards or other normative 
documents: 

• Limits and methods of measurement of radio disturbance characteristics of 
industrial, scientific and medical (ISM) radio frequency equipment:  
EN55011:1992 

• Electromagnetic compatibility generic immunity standard Part 1: Residential, 
commercial and light industry: 
EN50082-1:1992 

• Safety requirements for electrical equipment for measurement, control, and 
laboratory use Part 1: General requirements: 
EN61010-1:1990, and Amendment 1:1992 

 
Following the provisions of the following European Directives: 

• Electromagnetic Compatibility Directive 
89/336/EEC 

• Low-voltage Directive 
73/23/EEC 

 
 

Signed: Date: November 27, 2006 
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1.3 Declaration of Compliance 

 

Electronic Controls Design, Inc. 

 

4287-B S.E. International Way 
Milwaukie, Oregon U.S.A. 97222-8825 
(503) 659-6100 / (800) 323-4548 
FAX: (503) 659-4422 

Declaration of Compliance 
EC Directive RoHS 2002/95/EC 

 
Product: "Xpert Ready" SMG (RoHS) Part number: E45-7647-45 

 SMG Power Pack Battery (RoHS)  E45-7647-30 
 "Xpert Ready" SMG W/PP (RoHS)  E45-7647-40 

 
This document certifies that the products under the above mentioned part numbers 
manufactured by Electronic Controls Design, Inc. are in compliance with Directive 
2002/95/EC of the European Parliament and of the Council of 27 January 2003 on the 
restriction of use of certain hazardous substances in electrical and electronic 
equipment (RoHS Directives). These products have been identified as RoHS compliant 
because they do not exceed the maximum limit for following six substances: 

 
Substance Maximum Limit (ppm) 

Cadmium (Cd) 100 
Lead (Pb) 1000 (1) 
Mercury (Hg) 1000 
Hexavalent Chromium (Cr6+) 1000 
Poly Brominated Biphenyls (PBB) 1000 
Poly Brominated Diphenyl Ethers (PBDE) 1000 

  
(1) Maximum limit (ppm) does not apply to applications for which exemptions have 
been granted by the RoHS Directive. 
 

Name: Rex Breunsbach   

Signed: Date: 05/03/2006 

Title: CEO   
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1.4 How to Use This Users Help Guide 

This OvenWATCH® Users Help Guide explains how to use the ECD OvenWATCH® 
Product Quality Monitoring System and software. 
 
This Users Help Guide is written for users of varied experience. If a section covers 
information you already know, feel free to skip to the next section. 

• You do not need to be a computer expert to use this manual or the software. 
• The manual assumes you are familiar with Microsoft® Windows®. 

 

The hardware portions of this manual are written to reflect 
SuperM.O.L.E.® Gold firmware versions 9.08 and higher. The software 
portions reflect versions 1.12c and higher. 
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1.5 Terms Used 

ECD. introduced the original M.O.L.E.® (Multichannel Occurrent Logger Evaluator) in 
1986. Over the years ECD has produced several models of the M.O.L.E. ® for use in a 
wide variety of applications. In this Users Help Guide, we may refer to the 
SuperM.O.L.E.® Gold data recording device as the M.O.L.E. ®. 
 

The following statements describe special terms that will be used in this Users 
Help Guide: 

 
Informs the user that the note includes important information. 

 
Informs the user that the note includes a handy tip. 

 

Hardware Terms: 

 
Informs the user that the note identifies conditions or practices that could 
result in damage to the equipment 

 
Informs the user that the note identifies conditions or practices that could 
result in personal injury or damage to property other than the equipment. 

• “Xpert Ready”, refers to the M.O.L.E. ® being configured to interface with the 
AutoM.O.L.E. Xpert 3 System. 

• Thermocouple, may be referred to as T/C. 
Software Terms: 

• OvenWATCH® software may be referred to as OW SPC. 
• Workbook, contains all of the worksheets and the uploaded data set saved with 

file extension (.MOW). 
• Worksheet, the individual pages or sheets in the workbook file. 
• Data Set, multiple data runs uploaded into the workbook file. 
• Data Run / Experiment, the data uploaded from the M.O.L.E. ®. 
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1.6 Fonts Used 

This manual uses a special font to indicate terms or words that can be found directly on 
the display of the oven computer. 
 
For example: 
On the File menu, select Open Workbook to open a new workbook file”. This font 
indicates the words Open Workbook and File are actually found on the computer display 
as menu items. 
 

1.7 Product Symbols 
 
The following symbols may be present on the Product: 

 
Direct Current (DC) Power 

 
Alternating Current (AC) Power 

 
CAUTION: Whenever this internationally recognized symbol is used on the 
product, additional information concerning that particular feature or function 
appears in the manual. 

 
WARNING: Electric Shock or Energy Hazard 

 

1.8 Cleaning Instructions 

The product must never be immersed in water or any other cleaning agent. Wipe the 
exterior of the enclosure with a cloth dampened with water. 
 
IPA alcohol is the only type of solvent that is acceptable to clean the M.O.L.E. or any of 
the system components. All other types are not recommended 

 
To prevent product damage, do not clean the product using organic 
solvents. 
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1.9 Operator Safety Information 

The safety information in this section is for the benefit of operating personnel.  Warnings 
and Cautions will also be found throughout the manual where they apply.  
 
Hardware changes or modifications to the components are not expressly approved by 
ECD. and could void the warranty of the product. 

 

The warranty will not cover damage caused by neglect or abuse of this 
product. To maintain the safety features incorporated in this product, 
operation must be in strict compliance with the requirements specified 
herein. 

For protection of the components, observe the following: 

 
• NEVER permit the M.O.L.E. or the Power Pack battery to exceed the maximum 

specified internal temperature as permanent damage may result. (Refer to 
Appendix A: Specifications). 

• NEVER expose the M.O.L.E. or Power Pack battery to temperatures below the 
specified minimum for extended time periods. This may damage the re-chargable 
Power Pack battery. 

• NEVER connect the M.O.L.E. input channels to objects at elevated electrical 
potentials. The input channels are not isolated from each other or from the data 
port common. 

• NEVER operate the OvenWATCH® components in flammable or explosive 
atmospheres. Such usage constitutes a fire or explosion risk. 

• NEVER immerse the OvenWATCH® components in liquids. 
• NEVER subject the OvenWATCH® components to sharp impacts. 
• NEVER excessively stress the PC Interface cable. 
• NEVER expose the OvenWATCH® components to corrosive environments. 

 

When removing the M.O.L.E. from any temperature environment, whether 
in a Thermal barrier or not, be careful of extreme temperatures and use 
protective gloves. 



♦8♦ OvenWATCH® Users Guide 

 
Battery Warnings: 

• Replace the batteries with same type only. (Clock Battery: Panasonic No. 
BR2032, or equivalent). (Rechargeable Power Pack battery, ECD Part No. E45-
7647-30). Using alternate batteries may present a risk of fire or equipment 
damage. 

• Charge the “Re-chargeable” Power Pack battery using only the ECD approved 
charger. 

• Do not attempt to recharge the Calendar/Clock battery, disassemble, or dispose 
of in fire. Always dispose of used batteries promptly and properly. 

• Do not expose to temperature above 100°C (212°F). 
• Keep the batteries away from children. 
• The batteries may explode if mistreated. 
• The batteries contain electrolytes. 
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2.0 System Description 

 

2.1 SuperM.O.L.E.® Gold 

The M.O.L.E.® is compact and durable. One end has input connectors for attaching up 
to six sensors and the other end is the removable Power Pack battery. The M.O.L.E.® 
also has a four-pin Data port, Start/Stop button, and an Activity LED. 

 
SuperM.O.L.E. Gold Features 

M.O.L.E. functions: 
• Thermocouple/Sensor Inputs:This is where Type “K” or “S” Thermocouples and 

the optional Relative Humidity sensors are connected. 
• Start/Stop button: Allows the user to start and stop data collection. 
• Power Pack battery: Supplies power to the M.O.L.E. 
• Data Port: Transfers data through the PC Interface cable to the PC. 
• Activity LED: Indicates what state the M.O.L.E. is in, such as: Power On (flashing 

at log interval), Power Off (no illumination), Data transfer (steady illumination), 
and Reset complete (quick flashing for 2 seconds). 
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2.1.1 Power Pack Battery 
Because the M.O.L.E. is powered by the Power Pack battery, it is important to make 
sure it is charged and operating properly. OW SPC records the voltage of the Power 
Pack and reports this information in the M.O.L.E. status box. Refer to M.O.L.E. Status 
for more information. 

 
SMG Power Pack Battery 

When the Power Pack needs to be re-charged use the charger supplied with the kit and 
the instructions in section Charging the Power Pack Battery. It is also recommended 
that a spare Power Pack battery be ordered so that one battery is charging while the 
other one is being used. 
2.1.2 Calendar/Clock Battery 
The M.O.L.E. has another battery that powers an internal calendar and clock. This 
battery is not rechargeable and has no status indicator. The expected battery life is 
about 2-3 years. 

 
Calendar/Clock battery 

 

If the M.O.L.E. calendar and clock does not seem to operate (it resets 
itself), the battery may be discharged. For information on replacing the 
calendar/clock battery refer to section Changing the Calendar/Clock 
Battery. 
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2.1.3 Uni-Barrier & Yellow Jacket 
The Uni-Barrier with Yellow Jacket is the standard barrier in all our Lead-Free profiling 
kits, including the wireless RF kit. A thermal barrier is the protection the M.O.L.E. needs 
to ensure longevity through harsh environments. With piano-hinged stainless steel 
construction, sheathed in cool-to the touch high-temperature fabric, this barrier is rated 
for 17 minutes at 300C steady state ambient, ideal for lead-free reflow and wave 
soldering work. 

 
Uni-Barrier 

 
Uni-Barrier w/Yellow Jacket 

 
This Barrier combination is light- weight and thin (32.5mm [1.28"]). 
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2.2 Station 

The OvenWATCH® Station is a multipurpose Thermocouple Multiplexer and upload 
station where the user inserts the M.O.L.E. to record oven profile measures, upload 
data runs, and to charge the Power Pack Battery. 

 
Station 

Station Features: 
• M.O.L.E. Port: This is where the M.O.L.E. is inserted into the Station to record 

and upload data or charge the Power Pack battery. 
• Status Indicators: The status indicators are LED’s that display the status of the 

oven (i.e. Power On, In Specification and Alarm). 
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2.3 Zone Temperature Probe 

The Zone Temperature probe is installed inside the reflow oven and has K-Type T/C 
sensors positioned in the center of each oven zone along the length of the probe. 

The OvenWATCH® system has two Zone Temperature 
probe styles available, a solid shell probe and a flexible 
probe. Either style may be installed depending on your 
oven requirements. 

(Solid Shell) Flexible 
Zone Temperature Probe 

This sensor is connected to OvenWATCH® Station and is the component that reports 
the actual zone temperatures. 
 
  



♦14♦ OvenWATCH® Users Guide 

2.4 Software Description 

This section presents an overview of a workbook management window. When the 
software is started, it will automatically load the previously saved workbook file. 

 

The first time the software is started a sample file (i.e. OWSample.mpc) 
will be opened for users to familiarize themselves with the program. It is 
recommended when the user starts collecting process data, a new or 
exiting workbook should be used. 

OW SPC Workbook Features 
The workbook has several features as described in the following section. 

 

Workbook Features 
n Title Bar: This bar contains the program name, version, and the active workbook 

file name.  
o Menus: These menus contain the commands and tools for each worksheet. 

Each worksheet may contain different commands that supply specific support for 
each worksheet. Individual worksheet menus are described in detail in their 
specified sections of this manual. 
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p Toolbar: The Toolbar has buttons to serve as shortcuts to the menu commands. 
Individual worksheet toolbar buttons are described in detail in their specified 
sections of this manual. Each worksheet may have different items on the toolbar 
because of the different features offered by each worksheet. 

q Worksheet Tabs: These tabs are used to gain access to each worksheet. There 
are six standard worksheets and up to nine optional SPC sheets. These tabs are 
located on the bottom left of the display. 

 
Worksheet Tabs 

 To a view worksheet, use the mouse pointer to click on a worksheet tab. The 
worksheet tab will then become highlighted, and the worksheet will now be 
visible. 

 
The keyboard does not allow access to the worksheets. The only way to 
select the worksheet is by using the mouse pointer. 

 
Selecting a Worksheet 

r Tab Scroll Arrows: These arrows are used to view other worksheet tabs if the 
Horizontal scroll bar is covering them. Worksheet tabs may be hidden behind the 
horizontal scroll bar. To view them, the user can either use the Tab Scroll Arrows 
located on the left of the worksheet tabs, or use the Split-bar. 

s Split-bar: The Split-bar on the tab bar lets the user slide the Horizontal scroll bar 
to the left or right, so all of the worksheet tabs can be viewed. This feature is 
located on the left edge of the Horizontal scroll bar. 

t Status Bar: This bar on the bottom of the worksheet display, shows the available 
Help information, mouse pointer X-Y position, current date and time. 
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u Horizontal & Vertical Scroll Bars: The worksheets have both Horizontal and 
Vertical screen scroll bars so the non-visible areas of the worksheet can be 
scrolled into view. The Horizontal scroll bar is located in the lower right corner 
and can be scrolled left or right by pressing the left or right arrows located on 
each end of the scroll bar. The user may also scroll the display by sliding the 
center scroll bar left or right. The Vertical scroll bar located on the right side of 
the screen has the same features as the Horizontal scroll bar except it scrolls the 
worksheet display up and down. 

 

It is recommended that the minimum PC display area be set to 800 x 600. 
For best performance set the display to 1024 X 768. Refer to Microsoft® 
Windows® documentation for details. 
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3.0 Operation 

 

3.1 Step 1 - Create a Baseline Profile 

The OvenWATCH system requires a Baseline Profile to be established prior to 
recording profile measures. 
 
If you have created profiles using a different program such as SuperM.O.L.E. Gold SPC 
and/or AutoM.O.L.E. Xpert the Import command on the Spreadsheet worksheet imports 
the profiles into the OvenWATCH software. (Refer to section Import for more 
information). 

 
If you have an established Baseline Profile in the current workbook, you 
may proceed to Step 2 – Create a Product. 

 
3.1.1 Experiment Setup 
After the hardware is setup and the software is installed, use the following steps to 
perform an experiment using the SuperM.O.L.E. Gold. 

1)  Prior to beginning an experiment, compile a list that describes the product and 
conditions that are about to be tested. Calculate and write down the duration of 
the process. Document the Temperature setpoints, prescribed conveyor length 
and speed, or the prescribed process time. This product information can be 
added to the Workbook file using software features, after the collected data is 
uploaded to the software. 

2) Make sure the M.O.L.E. Power Pack is fully charged. The battery status in the 
M.O.L.E. status box on the Profile worksheet displays the battery voltage at the 
time when the data is uploaded from the M.O.L.E.. The voltage level should be 
4.8 volts or higher. 
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3) Insert the M.O.L.E. into the Station. 

 
Power Pack Charger 

 
A completely discharged Power Pack takes about 14 hours to be fully 
charged. 

 

The Power Pack battery can be charged continuously whenever the 
M.O.L.E. is not being used, however, if the M.O.L.E. is going to sit idle for 
five days or more, you may want to remove it from the Station. 
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4) Start the software program by double-clicking the OvenWATCH icon from the 
desktop or selecting it from the ECD OvenWATCH program sub-menu. 

 
Program Group 

5) Open a desired workbook file and select the Profile worksheet tab. 

 
Profile Worksheet 

6) Select the Configuration Wizard command from the M.O.L.E. menu and the 
Configuration dialog box appears. 
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7) Click the Auto command button to have the software automatically find the COM 
port the M.O.L.E. is connected. If the M.O.L.E. is not detected, there is a 
communication problem (Refer to section Communications Problems for 
additional help). 

 
Configuration 

8) Click the OK command button to use the selection and continue to the M.O.L.E. 
Settings dialog box. 

9) Type a company, operator, or machine name in the text box. 

 
M.O.L.E. Settings 

10) Click the OK command button to store the information in the M.O.L.E. and 
continue to the Configure M.O.L.E. Hardware dialog box. 
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11) Click the check box beside a corresponding channel to turn it “ON” or “OFF”. If a 
channel is “OFF”, it does not collect data for that channel, increasing battery life. 

 
Configure M.O.L.E. Hardware 

12) Enter an interval at which the M.O.L.E. records data points by using the slider(s) 
or manually typing in the corresponding text box. The maximum interval for the 
M.O.L.E. is 23:59:59 hours (one data point per day) and the minimum interval is 
0.2 second (one data point every two-tenths of a second). 

 

When using the M.O.L.E. with RF Option the minimum interval is 0.5 (one 
data point every five-tenths of a second) and when one channel is active, 
the minimum interval is 0.1 second (one data point every tenth of a 
second). 

13) Enter the number of data points the M.O.L.E. will record during the data run. The 
maximum number is dependent on the number of channels turned on. The 
maximum data points the M.O.L.E. can collect are displayed above the text box. 
When the number of data points collected and the recording interval have been 
selected, the software displays the corresponding time the experiment will take 
beside Total Time = text in the lower right corner of the dialog box. 

 

When M.O.L.E. configure options are modified, the data is calculated and 
then amount of profiles the user can expect from the power pack battery 
(based on a fully-charged power pack battery) is displayed in the lower 
right corner next to the Profiles Per Battery line. 
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Optional configurations: 
• Enter a threshold temperature to “trigger” the M.O.L.E. to start recording data by 

using the slider or by entering it in the text box. When any active channel reaches 
that temperature, the M.O.L.E. will begin to record data. This option can trigger 
the profiler when the temperature cools down to the threshold temperature by 
selecting the (-) option button, or heating up to the threshold temperature by 
selecting the (+) option button. If this option is not used for temperature 
triggering, select the Off option button. 

• Enter how many data points to delay “trigger” the M.O.L.E. to start recording data 
by using the slider or by entering it in the text box. The data point entered will 
“trigger” the start of data collection when the specified data point is reached in 
the process. The actual delay is equal to the Interval times the Pts Dly. 

14) Click the OK command button to save the configuration and continue to the Set 
Instruments Clock dialog box. 

15) Enter the correct month, day, year, hour, minute, and second by adjusting the 
slider(s) or manually typing in the corresponding text box. 

 
Set Instrument Clock 

 

When the Set Instrument Clock dialog box appears the current computer 
clock setting is automatically entered in the text boxes. 

16) Click the OK button to reset the clock. 
17) Remove the M.O.L.E. from the Station and data can now be collected. 

  



OvenWATCH® Users Guide ♦23♦ 

3.1.2 Data Collection 
1) Attach sensors to test product. 

 

When soldering a T/C sensor to a component with high temperature 
solder, use Kester SN10 (or equivalent) for 183°C eutetic solder or Kester 
SN5 (or equivalent) for no-lead soldering. 

2) Unwind the sensor leads and attach the Micro connectors to the M.O.L.E.. Make 
sure to connect them to the same channel(s) that were configured to accept 
them. For example, if the M.O.L.E. is configured to have Channels 1 through 3 
active, be sure the sensors are attached to the same three channels. (The 
connectors are polarized so they cannot be connected wrong). 

 
Kapton® tape, aluminum tape and Temprobeä can also be used to hold 
T/C wire to the test assembly. 

 
T/C Attachment 

 

If fewer than six sensors used, it is important that the unused channels 
are turned OFF. 
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3)  Place the M.O.L.E. in the appropriate Thermal barrier making sure the 
Thermocouple and/or Sensor wires are not damaged. 

 
M.O.L.E. Setup 

4) After the oven stabilizes, press the Start/Stop button on the M.O.L.E. once to 
initiate data collection. When the M.O.L.E. is “ON”, the Activity light will flash 
quickly and then flash at the log interval for the duration of the experiment. 

 

The Start/Stop button will need to be pressed even if the M.O.L.E. is 
configured to start with the Trigger Temperature or Points Delay feature. 

5) If you are using the 1.0” Uni-barrier to protect the M.O.L.E., insert the opposite 
end away from the T/C leads inside the Yellow Jacket barrier cover. 

 

Never permit the M.O.L.E. to exceed the absolute maximum warranteed 
internal temperature, as permanent damage may result. The warranty will 
not cover damage caused by exceeding the maximum specified internal 
temperature. 

6) Pass the thermally protected M.O.L.E. and test product through the process. 

 

It is highly recommended that protective gloves are used when retrieving 
the M.O.L.E. from the oven and when opening the Thermal barrier. 
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7) As the test product and the M.O.L.E. emerge from the process, carry the test 
product with sensors attached and the M.O.L.E. in the Thermal barrier to a table 
or flat surface. 

 

If you remove a sensor before the M.O.L.E. has stopped collecting data, 
the data for that channel might become distorted. 

8) Open the Thermal barrier and if the Activity LED is still flashing this means the 
M.O.L.E. is still logging and it must be turned “OFF”. To turn the M.O.L.E. “OFF” 
press and Hold the Start/Stop button until the Activity LED turns off, and then 
release the button. 

 

When turning the M.O.L.E. “OFF”, do not release the button until the light 
goes off. Pressing the Start/Stop button briefly will restart the data 
collection process and erase all the data in memory. 

9) Remove the M.O.L.E. from the Thermal barrier. Handle it carefully, as the case 
may still be warm. 

10) Disconnect the sensors from the M.O.L.E. and place it near the computer that 
has the software installed. 
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3.1.3 Transferring Data 
When data is transferred from the M.O.L.E. to the PC, it is uploaded and saved in a 
Workbook file as a Baseline Profile. 
 
To Read M.O.L.E. Data: 

1) Insert the M.O.L.E. into the Station. 
2) Select the Read M.O.L.E. Data command from the M.O.L.E. menu, and the Read 

Data from M.O.L.E. status box appears showing the status of the uploading 
process. To discontinue click the Cancel command button at any time. 

 
Read M.O.L.E. Data Status Box 

 

If a message box appears stating that the M.O.L.E. is not responding, 
check the COM port configuration, cable connections, and/or the M.O.L.E. 
itself (i.e. battery). 

3) When the data transfer is complete the data run is automatically uploaded into a 
data run row on Spreadsheet worksheet and the Oven dialog box appears.  

 

The software automatically populates the amount of Zones, names and 
lengths. 
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4) Enter the oven conveyor speed and zone temperatures into the oven dialog box. 

 
Oven Settings 

5) Select a solder paste from the list box and a Profile Type (Ramp-Soak-Spike or 
Ramp-To-Spike). 

 
 Select Paste 

6) To complete the download process, select the Apply button to display the data 
run and oven information on the Profile worksheet Data Graph. 

 

When the Data Graph is populated with a new profile, the software 
automatically aligns the X-axis maximum peak values for each Data Plot 
and the oven model so the results can be easily compared during 
analysis. 
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3.2 Step 2 - Create a Product 

The first step to monitoring product quality is creating a product. 

 
If you have product established, you may proceed to Step 3 – Alarm 
Configuration. 

Creating a Product: 
1) Select the Watch worksheet tab. 

 
Watch Worksheet 
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2) Select the Products command button from the Watch control panel and the New 
Product Definition dialog box appears. 

 
New Product Definition Dialog Box 

3) Select the New command button to add a product or the Copy command button to 
clone an existing product. 

 

The Product options are password protected and have a preset password 
Admin. This password will be needed unless it has been changed. Refer 
to section Passwords. 

4) Enter a new product ID in the Product ID text box. 

 

If you decide to copy an existing product, you may use the following 
steps to modify the cloned product or you can save the existing 
configuration and proceed to Step 3 – Alarm Configuration. 
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5) Select the Select Profile command button and the software will automatically 
display the Spreadsheet worksheet where you can select the desired Baseline 
Profile for the product. 

 
The number of zones in the Baseline Profile must match the number of 
zones in the oven. 

 
Select Profile 

• Select the Add Probe Temps command button to add the probe temperatures from 
the Baseline Profile. 

• Select the Advanced command button to edit the Oven settings from the Baseline 
Profile. 
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6) Select the Select Paste command button to assign the desired paste and profile 
type. 

 
Paste Specifications Dialog Box 

7) Select the Select Photo command button to assign an identification photo. 

 
Image Dialog Box 

 

Once a photo is assigned, the user can use the Photo Shop tools to 
enhance the photo by selecting the Edit Image command button on the 
New Product Definition dialog box. 
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8) Select the Save command button to save the new product 

 
Completed New Product Definition 
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3.3 Step 3 - Alarm Configuration 

The user can assign Alarms and the method of notification for the currently selected 
product. 
 
To assign Alarms: 

1) Select the Watch SPC worksheet tab. 
2) Select a desired Alarm pop-up bar. 

 
Local Alarms 

3) Set an alarm by clicking the check box adjacent to the desired control/spec limit. 
To use the suggested Paste Spec limit values, click the Upper and/or Lower spec 
command buttons. This will auto-populate and check the alarm box for that Spec 
text box. 

4) Repeat for all desired profile measures. 
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5) Select the Alarms command button from the Watch control panel and the global 
alarms table appears. The spec limits previously selected from the Watch SPC 
worksheet are populated on this global Alarms table. The user can decide to 
change the spec limits or add additional spec limits on this table. 

 
 Alarms-Table 

6) Select the Alarm – Specification limits check box to have the software enable 
alarms for the selected parameters. When the specification limits cells are 
GREEN the spec limits are not violated, if the cells are RED the spec limits have 
been violated. 

7) Select the Warnings check box to have the software monitor the selected 
parameters and warn the operator when the parameters are approaching the 
specification limits. This warning can be based on a % of the spec limit or the 
parameters CpK limit. When a spec limit alarm is active for a parameter, a yellow 
circle will appear beside the Present Value (PV) of a parameter. If the value 
violates the specified warning level, the cell will turn YELLOW. 

8) Select the Alarm Notification check box to activate the Alarms – List dialog box 
and have the OvenWATCH station alarm.  

 
If the optional Light tower or SMEMA Interface is installed with the 
system, activating the Alarm Notification will also signal these options. 
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9) An external Alarm notification can also be activated. To activate, select the check 
box adjacent to Email and/or Pager options to activate. When either of these 
options are selected, the associated configuration dialog boxes appears. 

 
Email Configuration Dialog Box 

 
Pager Configuration Dialog Box 

10) Enter the appropriate configuration information. You may have to contact your 
internal Information System Manager and your Pager service to get the correct 
settings. 

11) Select the SMEMA Options check box to activate the alarm functions for the 
optional SMEMA option. 

12) Select the Barcode command button to setup the optional barcodes and missing 
board detection. 

 

If the Barcode alarm setup command button is dimmed, it must be 
authorized to prior to use. (Refer to Section   Software Authorization for 
additional information) 

13) Select OK to accept the Alarm settings or Cancel to return to the worksheet. 
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3.4 Step 4 - Record Profile Measures 

Now that a product has been properly configured, the user can start recording profile 
measures. 
 
To record profile measures: 

1) Select the pre-defined product from the Product ID selection box. 

 
Product Selection Box 
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2) Start the product monitoring process by selecting the Start command button on 
the Watch Control panel. 

 
The Start command can also be accessed on the OvenWATCH menu. 

 
Start Recording 
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3) When the OvenWATCH is recording data a Dynamic Profile is displayed in the 
Data Graph as dashed Data plots. They represent a predicted profile based on 
the current temperatures and conveyor speed of the oven and the Baseline 
Profile. 

 
Dynamic Profile 
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If an alarm is triggered during the recording process, the Alarms - List appears. 

 
Alarms-List 

Once the Alarms-List appears select the Acknowledge command button to stop the 
alarm. Once it has been acknowledged the operator can then proceed to troubleshoot 
the problem. Once the problem has been resolved selecting the Clear command button 
will remove the alarm from the Alarms List. 

 

Acknowledged Alarms will not sound again even if the alarm condition 
persists. Once the alarm condition is cleared, and the same alarm 
condition remains the alarm will be displayed in the Alarm List again. 
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3.5 Step 5 - Playback 

After product data has been recorded, the user can review all of the data recorded in 
the database by using the Playback command. 
 
To review product data: 

1) Select the Playback command button on the Watch Control panel and the 
Playback dialog box appears. 

 
The Playback command can also be accessed on the OvenWATCH menu. 

 
Playback 

2) Select a product from the Product ID drop-down box. 
3) Select a playback start date and time. 

 

After selecting a Product the user can start the playback process without 
specifing a start date or time. If a start date or time is not specified the 
software will automatically rewind 24 hours from the displayed date and 
time. 
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4) Select the Play forward or Play back button to start the Playback process. The 
software will search the database for the closest logged data points that match 
the selected product and time. 

 

When playing back data, if the specified date and time criteria is before 
the first logged data point for the selected product, the software will 
automatically forward to the first data point logged. If the date and time 
criteria is after the last point logged the playback will remain idle. 

5) When the playback process has started a playback label appears in the upper 
right corner of the Data Graph. 

 
Playback 

6) To stop the playback process press the stop button  located between the 
play forward and play back buttons. 
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3.6 Step 6 - Search 

As previously discussed in Step 5 – Playback, recorded profile measures can be 
reviewed using the Playback command. Search works with the Playback command by 
allowing the to search for a certain recorded event and then starting the Playback at the 
exact time the specific event occurred. 
 
To search events: 

1) Select the Search command button on the Watch Control panel. 

 
The Search command can also be accessed on the OvenWATCH menu. 

 
Search Event History Dialog Box 
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2) Select the criteria and search will then find events to match. The user can also 
select a product from the Product ID drop-down list or select the desired date and 
time criteria. To search for specific events select a desired event(s) in the Filter 
Events list box and select the Run Query command button. 

 
Search Results 

Once the search is complete the user can select an event and then use the Playback 
command to display it on the Data Graph. 

 
To search events for all products select the Run Query command button 
without selecting any search criteria. 
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4.0 Worksheet Descriptions 

 

4.1 The Welcome Worksheet 

The Welcome worksheet is the introductory worksheet. This worksheet contains an 
introductory illustration and a text box for entering a company or workbook name. 
 
Welcome worksheet features: 

• Menus and Toolbar 
• Company/Report Name Text Box 

 
Welcome Worksheet 
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4.1.1 Menus and Toolbar 

• Menus: File, View, M.O.L.E., and Help. 
• Toolbar Buttons: Print, Zoom In, Zoom Out, 100%, Read M.O.L.E., Receive RF, 

and About. 

 
Welcome Worksheet Menus and Toolbar Buttons 
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4.1.2 Company/Report Name 
The text box located on the bottom half of the Welcome worksheet allows the user enter 
a company or report name. 
 
To enter a name: 

1) Using the mouse pointer, highlight the text in the text box. 
2) Type a desired name and then hit the [enter] key to accept or [esc] to cancel. 

 
Entering a Company Name 
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4.2 Spreadsheet Worksheet 

The Spreadsheet worksheet contains Baseline Profile data that is collected by the 
M.O.L.E. and put into standard spreadsheet format. Each row in the spreadsheet 
represents one data run. 
 
Spreadsheet Worksheet features: 
n Menus and Toolbar 
o Parameter Groups (color coded) 
p Parameter Labels 
q Parameter Units 
r Data Run Rows 
s Selected Data Run 
t Filters 
u Statistics 

 

 
Spreadsheet Worksheet 
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4.2.1 Menus and Toolbar 

• Menus: File, Edit, View, Format, M.O.L.E., Window, and Help. 
• Toolbar Buttons: New, Open, Save Workbook, Print, Undo, Redo, Zoom In, 

Zoom Out, 100%, Align Left, Center, Align Right, Bold, Italic, Underline, Read 
M.O.L.E., Configure M.O.L.E., Receive RF, and About. 

 
Spreadsheet Worksheet Menus and Toolbar Buttons 
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4.2.2 Parameter Groups 
Parameter Groups are the headers for a specific group of data parameters collected by 
the M.O.L.E.. They are color coded with the associated Parameter Labels so they can 
be easily identified together. 

 

The width of each parameter column can be adjusted to be larger or 
smaller by placing the mouse pointer over a split line dividing the 
parameter columns and sliding it to the desired width. 

 
Parameter Group 

The Parameter Groups are defined as the following: 
User Defined Parameter Group: The user can customize these parameter 

columns, which can be used to identify a row 
with unique information about that run (i.e. 
shift, operator, line number, part number). This 
information will also appear in the Tool Status 
box on the Profile worksheet. 

General Parameter Group: This group contains file information associated 
with the run such as; date and time, (of profile) 
and the data file tag. 

M.O.L.E. Parameter Group: This group contains the physical condition of 
the M.O.L.E. at the end of the run. 

Oven Parameter Group This group contains the conveyor speed that is 
configured by the user.  

 
  



♦50♦ OvenWATCH® Users Guide 

4.2.3 Parameter Labels 
The Parameter Labels are where all of the specific parameters for each group are listed. 

 
Parameter Label 

 

4.2.4 Parameter Units 
The Parameter Units are the units of measurement for that parameter. For example, in 
the M.O.L.E. Group Parameter, the Parameter Label Temp: is in °C. 

 
Parameter Units 
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4.2.5 Data Run Rows 
All of the Baseline Profiles uploaded into a workbook file are listed on the Spreadsheet 
worksheet as individual data run rows. The first data run uploaded into the workbook file 
is on the bottom and the most recent data run uploaded is on the top. 
 
When any data run row is selected, all of the cells in the entire row are highlighted in 
purple and blue. The purple cells indicate that the cells can be modified and the blue 
cells indicate the data cannot be modified. 
 
When any individual data cell in a data run row is selected, all of the cells in the entire 
row are highlighted in green and yellow. The green cells indicate that the cells can be 
modified and the yellow cells indicate the data cannot be modified. 
 
The data run rows can also be moved into any order desired. This is useful when the 
user wants to place similar data runs together. 
 
To change the data run order: 

1) Select the number cell of a row with the mouse pointer. The row will then become 
highlighted in purple and blue. 

2) Drag the row and drop it to a desired location. 

 
Drag and Drop Data Rows 
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4.2.6 Selected Data Run 
When a data run row is selected, the data for that row will be shown in the Sel= row 
located at the bottom of the data run rows. 

 
Selected Data Run 

 
Selected rows and columns can be “copied” by pressing keys (CTRL + C) 
and then “pasted” (Ctrl + V) into other spreadsheet applications. 
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4.2.7 Filters 
There are Filters for each parameter label that filter specific data out of runs listing. 

 

Filtering more than one column at a time acts as a Logical AND Function. 
All conditions of all set filters must be met for data row(s) to remain 
visible. 

How to use the Filter function: 
1) Click the Filter button to reveal the unique data as populated in that column 

under that particular parameter label. 
2) Select a desired data value to filter, or the two standard filters All and Special. 

 
Filter Function 
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To use the All option: 
1) Select All to reset the filter for that column and view all of the data run rows that 

meet the other column filters. 
 
To use the Special option: 

1) Select Special to select data run rows within a range of values. There are multiple 
options to select information to filter by clicking the appropriate relational 
operators option button. The user can either select data from a populated list or 
type it in the text box on the top of the column. 

 

= equal to >= greater than or equal to 

> greater than <= less than or equal to 

< less than <> Not equal to 
Filter option buttons 

2) Select a data filter by: 
• Clicking the greater than relational operator option button beside the left data 

column. 
• Click a parameter value from the list or type it in the text box. 
• Click the AND logical operator option button. 
• Click the less than relational operator option button beside the right data column. 
• Click a parameter value from the list or type it in the text box. 

 
The Clear command button can be selected at any time to clear the 
selections and the new values can be selected. 
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3) Click the OK command button to accept the selected data filters or Cancel to 
return to the worksheet without executing the filter request. 

 
Special Filter Feature Dialog Box 

In this example, the data filtered would be all times between, but not including 13:41:41 
and 16:55:30. 
 

 
To reset all of the data set rows to restore the entire set of collected 
data, click the Filter Reset button on the Spreadsheet worksheet. 
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4.2.8 Statistics 
There are rows located on the bottom of the Spreadsheet worksheet, which are the 
combined calculations for all the data runs that are currently being viewed in the 
Spreadsheet worksheet display. The following information is the definitions for each 
Statistics row: 

 
Statistics 

• N = Number of samples included in the calculations 
• Min. = The lowest value in the parameter column. 
• Max. = The highest value the parameter column. 
• Avg = The average of all values in the parameter column. 
• Std. Dev. = The standard deviation of the values in that column. 
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4.3 Profile Worksheet 

The Profile worksheet is where a selected data run is represented graphically. The 
software allows the user to analyze the data and to compute statistics based on the 
data. 
 
Profile worksheet features: 
n Menus and Toolbar 
o M.O.L.E. Status 
p Tool Box Status 
q Magnify Map 
r Auto Lag 
s Zone Matrix 
t Data Graph 
u Data Table 
v Status Bar 

 
Profile Worksheet 
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4.3.1 Menus and Toolbar 

• Menus: File, View, Profile, M.O.L.E., Tools, Navigate, Window, and Help. 
• Toolbar Buttons: New Workbook, Open Workbook, Save Workbook, Copy, 

Print, About, Magnify, Slope, Peak Difference, Overlay, Total Heat, 3-D, 
Measure, Notes, Prediction, Tolerance Band, Erase Objects, Erase All, Read 
M.O.L.E., Configure M.O.L.E., Receive RF, Zone Matrix, First (data run), Back 
(to previous data run), Next (data run), and, Last (data run). 

 
Profile Worksheet Menus and Toolbar Buttons 
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4.3.2 M.O.L.E. Status 
The M.O.L.E. STATUS box contains information about the status of the M.O.L.E. while it 
collected data for the selected Baseline Profile. 

 
M.O.L.E. Status Window 

• Max Internal T: This is the highest internal temperature logged during the 
displayed profile and is displayed in degrees Celsius. If the highest temperature 
logged is in the specified internal operating temperature range of is 0-54°C, it 
appears in BLACK. When the internal temperature is 55°C and above, it appears 
in RED indicating that the M.O.L.E. has reached the temperature warning zone. 

 

The software has two different internal temperature thresholds. 55-64°C 
is the M.O.L.E. is approaching the maximum recommended operating 
temperature of 65°C. Above 65°C is the maximum internal operating 
range. 

• Battery: The battery voltage measured during the upload of that run. The nominal 
range for normal operation is 4.1 to 4.7V. 

• Points: The number of data samples recorded at the configured interval. 
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• Active: Indicates which channels were active during the experiment. A number 
means an active channel; a “O” is an inactive channel. An "X" means an open or 
out of range T/C was detected on that channel during the data run. 

• Interval: Time between data shown in hours, minutes, seconds, and tenths of 
seconds data points: hh:mm:ss.t. 

• Date: Date of last data point logged. 
• Time: Time of last data point logged. 
• V: Firmware Version displays the operating code of the M.O.L.E. (This is where 

customer service will ask you to find the version number for the M.O.L.E.)  
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4.3.3 Tool Status Box 
The Tool Status box displays information on how to use a selected tool command and 
other information during tool use. Prior to using a tool command, the Tool Status box 
displays the Spreadsheet worksheet User definable column information that is 
associated with the selected Baseline Profile. 

 
Tool Status Box 
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When a Tool command such as Magnify is selected, a tip message appears in the box 
indicating how to use the Magnify tool by displaying “Click and drag to select area”. 

 
Tool Status Message 
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4.3.4 Magnify Map 
The Magnify Map displays a small map of the entire profile and indicates the area 
currently magnified with a red crosshatched box. 

 
Magnify Map 

 
For more information on the Magnify command refer to section Magnify 
Tool. 
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4.3.5 Auto Align 
If sensors are placed along a line parallel to the direction of flow in a conveyorized 
process so they enter and exit oven zones at different times, the resulting Data Plots lag 
behind one another. Auto Lag automatically aligns the X-axis maximum peak values for 
each Data Plot so the results can be easily compared during analysis. 

 
A Conveyor speed must be set to properly use Auto Lag. Refer to 
section Zone Matrix and/or Oven Configure for more information. 

 
Channel Lag Indicator 
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To use Auto Lag: 
1) Select the Auto Lag command button. The channel lag values will automatically 

be calculated, and the Data Plots adjust to reflect them. When Channel lag is 
enabled, a check mark appears in the Show Lag check box and a small triangle 
appears on the lower end of the process origin line. 

 

If Channel Lag values were previously entered in the Channel Lag dialog 
box, Auto Lag will automatically overwrite the current values. Refer to 
section Sensors for more information. 

To disable the Channel Lag: 
1) Click the Show Lag check box to remove the check mark and return the Data 

Plot(s) to the original positions. 

 
Auto Lag only used displayed channel Data Plots. Auto Lag values will 
not be calculated for channels that are not displayed. 
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4.3.6 Data Graph 
The Data Graph is a display that shows the data collected from the Baseline Profile 
overlaid on a graph. The user can analyze and highlight various process features with 
the tools listed below. 
 
Data Graph features: 
n X and Y-Axes and Labels 
o X-axis Scales 
p Autoscaling 
q Data Plots 
r Process Origin 
s X-Cursors 
t Temperature Reference Lines 
u Zones and Zone Sizes 
v Zone Temperatures 

 
The Data Graph 

The Data Graph features are described in the sections that follow. Some of these 
features described are also controlled using the appropriate menu options. Refer to 
Menu and Tool Commands for more information. 
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4.3.6.1 X and Y-Axes 
The Y-axis (vertical) displays the scale of the measured temperature. Lower values are 
at the bottom and higher values at the top.  
 
The Y-axis includes temperature labels on the left side of the graph. These four 
temperatures divide the vertical axis into four equal parts and are automatically scaled 
to fit the current Y-axis limits. These units can be displayed in Celsius or Fahrenheit 
using the Units command in the Preferences sub-menu on the Spreadsheet worksheet.  
 
The X-axis (horizontal) displays values data points collected. The X-axis can be 
converted from data points to time or distance using the Units command in the Profile 
menu. 
 
To see the X-value of any location on the Data Graph, the software provides three 
different methods: 

• The X/Y Readout in the Status bar continuously displays both X and Y-values at 
the location of the mouse pointer. Details of this feature are described in section 
Status Bar. 

• The X-value at the position of each X-Cursor is displayed in the Data table when 
the Value statistic is active. 

• The X-and Y-values for each data point in the raw data is listed in a table when 
the List-Print Data command is used. 
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4.3.6.2 X-axis Scales 
The user can select four different types of X scales for the X-axis. The scales are Point, 
Time – Relative (time measure from process origin), Time – Absolute (Time of day) and 
Distance. To change, select the Units command in the Profile menu.  

 
The scale is displayed only when a data tab other than Value is selected. 

 

 

 

 
Scale Types 

 
The Distance scale will not be accurate until an accurate conveyor speed 
is set. 

 
4.3.6.3 Autoscaling 
The software includes a powerful Autoscaling option to automatically scale the Data 
Graph so the data will always be visible and easy to work with. The software will 
automatically select a range of values for the Y-axes to ensure that all the data fits on 
the screen. The user can change the range of Y-values displayed in Manual mode by 
entering a manual mode using the Scaling command in the Profile menu. 

 
Another way to scale the graph’s X and Y-axes is to use the Magnify tool 
described in section Magnify Tool. 
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4.3.6.4 Data plots 
The Data Plots in the Data Graph represent the data for each of the sensors connected 
to the M.O.L.E.. Each sensor is represented by a different color that corresponds to the 
color of its sensor location description in the Data Table. 

 
Data Plots 

A Data Plot in the Data Graph can be suppressed or restored at any time by clicking the 
check box with the corresponding sensor description in the Data Table. This allows the 
user to view any combination of the Data Plots or individually. 

 

When two or more Data Plots overlap the same values, the Data Plots 
overwrite each other. For example, if the Data Plot that represents the 
sensor connected to channel 5 and channel 1 have the same value, the 
channel 5 Data Plot will only appear unless the user suppresses it. 

When printing a Data Graph in black and white, suppressing one or more Data Plots is 
useful for clearing a view of a Data Plot that is obscured by others near it. 

 
When printing the Data Graph in black and white, the Notes tool can be 
used to help identify each Data Plot. 
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4.3.6.5 Process Origin 
The Process Origin is a gray vertical line at the left edge of the Data Graph to indicate 
where the process starts. When Points or Distance units are being used for the X-
values, the X-values to the left of the Process Origin are displayed as negative and 
those to the right as positive. 

 
 Process Origin 
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To move the Process Origin: 
1) Select the Process Origin line by positioning the mouse pointer anywhere on the 

line. 
2) Press and hold the left mouse button. 
3) Move the line by dragging it left or right.  
4) Release the mouse button when the Process Origin is at the desired location. 

The X/Y Readout in the Status Bar indicates the true position of the Process Origin 
while it is being moving. After the mouse button is released, the X-Readout changes to 
zero at the Process Origin and displays negative numbers for X when the mouse pointer 
is moved to the left of the Process Origin. 

 
X-Cursor values are automatically adjusted when the Process Origin is 
moved. 

To display the distance of a conveyor process along the X-axis, adjust the Process 
Origin to the data point that was recorded at the start of the conveyor process. Now set 
the conveyor speed in the Oven Configure dialog box located in the Profile menu. 
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4.3.6.6 Conveyor Speed Indicator 
The Conveyor Speed Indicator displays the speed of the conveyor when the Baseline 
Profile data was recorded. It is a Magenta flag located at the top of the Process Origin. 

 
Conveyor Speed Indicator 
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4.3.6.7 X-Cursors 
The Data Graph has four X-cursors that indicate the temperature values at the 
intersection of a Data Plot with each X-cursor. When the Value Data Tab is selected, 
these values are displayed in the Data Table in four data columns labeled C1, C2, C3, 
and C4, representing X-cursor 1 through X-cursor 4 respectively. 

 
X-Cursors 
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To move an X-Cursor: 
1) Select the Value Data Tab. 
2) Position the mouse pointer over the X-cursor grip (the small triangle below a X-

cursor) then press and hold the left mouse button and drag it left or right 
releasing the mouse button when the X-cursor is at the desired location. 

• The user can also press the [tab] key to toggle select an X-cursor. When the 
desired X-cursor is selected, the small triangle will turn red. Then pressing either 
the left or right arrow keys will step the X-cursors. Each step is one pixel or one 
degree which ever is larger. This feature achieves cursor positions that are more 
precise. 

 
Moving the selected cursor can be pushed into other cursors causing 
them to move them ahead of it. 

The position of an X-cursor controls the values displayed in the Data Table. When an X-
cursor is moved, values in the Data Table are automatically updated. 
 
The Data Table includes a row for each of the sensors on the M.O.L.E.. The numbers in 
the four columns indicate the Y-values at the intersection of a Data Plot with an X-
cursor. Refer to Value for more information. 
 
When an X-cursor is dragged to a new position, it automatically snaps to the closest 
real X-value. Notice on highly magnified graphs that the cursor jumps from point to 
point. In an extreme case, if the graph is so highly magnified that there are no real X-
values to move to, the X-cursors cannot be moved at all. 

 

The Process Origin is the initial point from which all X-axis position data 
is calculated. After releasing the Process Origin at the appropriate point 
on the graph, X-cursor values are recalculated and displayed. 
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4.3.6.8 Temperature Reference Lines 
Temperature Reference Lines are colored horizontal lines that are positioned within the 
range of Y-values in the graph. Up to three Temperature reference lines can be added 
to the Data Graph using the Temp Ref Lines command in the Profile menu. 
 
In this example the Low Temp Ref Line is Green and located at 155°C. The Medium 

and High Temp Ref Lines are Blue and Red  which are located at 183°C. 

 
Temperature reference lines 

Temperature Reference Lines are used in analysis when the T Above Ref (Time above 
the Reference Line) statistic is active. T Above Ref statistic is described in section T 
Above Ref. 
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4.3.6.9 Zones and Zone Sizes 
The X-axis can be divided into zones that represent oven zones in a process. As many 
as thirty zones can be specified using the Zone Configure fields on the Oven Configure 
dialog in the Profile menu. Zones sizes are defined in units of length or time. 

 
Zones 

To view zones along the X-axis, click the Show Zones option button on the Oven 
Configure dialog box. When zones are displayed, they appear as two colored lines 
along the bottom of the data graph and as dotted vertical lines that extend top to 
bottom. The first zone begins at the Process Origin. When the Process Origin is moved, 
the zones move with it. 
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4.3.6.10 Zone Temperatures 
Two zone temperatures can be established for each zone using the Zone Temps fields 
on the Oven Configure dialog box. These temperatures might represent upper and lower 
boundaries for the acceptable range of values in that zone or the settings of upper and 
lower heating elements in that zone. 

 
Zone Temperatures 

Zone Temperature Lines appear in the Data Graph as colored bars at the temperature 
set for each zone. (Zone Temperatures can be displayed only after zone sizes are 
defined). Upper Zone Temperature Lines appear in the Data Graph as solid colored 
bars and the lower Zone Temperature Lines are dashed. 
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4.3.6.11. Zone Matrix 
A Zone Matrix appears above the Data Graph, when the Zone Matrix command in the 
Profile menu is selected. The user can enter value(s) for the Top and Bottom zone 
temperatures in the white cells of the matrix. 

 
Zone Matrix 
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4.3.7 Data Table 
The Data Table includes various values depending on which Data Tab is selected. The 
rows always indicate the channel and the columns vary depending on which data tab is 
active. 
 
Data Table features: 

• Sensor Locations 
• Channel Check Boxes 
• Data Tabs 
• Value Pop-up 
• Show/Hide Columns 
• Change Summary Stats Settings 
• Change Slope Calculator 

 
Data Table 
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4.3.7.1 Sensor Locations 
The location for each sensor labeled in the Data Table. The color and description 
indicates which Data Plot on the Data Graph it designates. 
 
To change a Sensor location description: 

1) Click the cell to the right and type the desired name and press the [enter] key, or 
use the Sensors command in the Profile menu. 

 
Channel Descriptions 
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4.3.7.2 Channel Check Boxes 
The Channel check boxes control whether the associated Data Plot is displayed on the 
Data Graph and whether the data for that channel are included in the data table. 
 
To view or remove a Data Plot: 

1) Click the channel check box beside a sensor location description to turn it “ON” 
or “OFF”. 

 
Channel Check Boxes 
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4.3.7.3 Data Tabs 
Data Tabs is where the user can view a variety of sensor information in the Data Table. 
 
The Data Tabs are: 

• Value 
• Time to Ref 
• T above Ref 
• Statistics 
• Zone Slopes 
• Summary Statistics 
• KPI  (Key Process Indicators) 

 

When the Magnify tool is used to zoom in on a portion of the Data Graph, 
the Data Table displays the statistics for those values that are displayed. 
(This feature does not apply to the Summary Stats Data Tab). 
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4.3.7.3.1 Value 
When the Value Tab is selected, the Data Table lists the temperature at the point where 
an X-cursor intersects a Data Plot. There are four X-cursors and the positions can be 
changed at any time by moving the X-cursor (Refer to the descriptions in X-Cursors). 
As an X-cursor is moved, the values in the Data Table are automatically updated. 

 
Value Data Tab 

 
Values in the Data Table depend on the units of the X and Y-axis. 
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4.3.7.3.2 Time to Reference 
When the Time to Reference Tab is selected, the Data Table displays the time it takes 
the channels to reach fixed Temperature Reference Line(s). Times are expressed as 
HH:MM:SS (H=hours, M=minutes, S=seconds). Up to three Temperature Reference 
Lines can be added to the Data Graph that are used in this statistic by using the Temp 
Ref Lines command in the Profile menu. 

 
Time to Ref Data Tab 
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4.3.7.3.3 T Above Ref 
When the T Above Ref Tab is selected, the Data table shows the amount of time each 
sensor measured data above the Temperature reference lines. Times are expressed as 
HH:MM:SS (H=hours, M=minutes, S=seconds) and are the total time above reference 
line regardless of when the value was above. 

 
T Above Ref Data Tab 

 
Temperature reference lines can be added, deleted, or moved at any time 
using the Temp Ref Lines command in the Profile menu. 
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4.3.7.3.4. Statistics 
When the Statistics Tab is selected, the first four columns of the Data Table displays the 
minimum and maximum temperature found for each Data Plot and the value of X (time, 
distance, or point number) at which it occurred. 
 
The last two columns of the Data Table displays the Average (Mean) and Standard 
Deviation of the temperature values recorded for each sensor. 

 
Statistics Data Tab 

 

If a portion of the Data Graph is magnified using the Magnify tool, the 
Data Table displays the Mean and Standard Deviation of the values 
currently displayed. 
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4.3.7.3.5 Zone Slopes 
When Zone Slopes is the active data tab, the Data Table displays the average slope in 
degrees/second of each Data Plot in each zone. The bold value in the data table is the 
Maximum slope for that profile. The example below has all six of the Maximum slopes 
located in zone 2. 

 
 Zone Slopes Data Tab 

 
The Slope Tool can also be used to determine the slope between any 
two points in the graph. Refer to Slope Tool for more information. 
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4.3.7.3.6 Summary Statistics 
When Summary Stats is the active data tab, the Data table displays a summary of 
primary statistics from the Profile. The summary statistics are always derived from the 
entire profile. 

 
Summary Stats Data Tab 

 
When the Magnify tool is used to zoom in on a portion of the Data Graph, 
the Data table statistics remain the same. 
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4.3.7.3.7 KPI (Key Process Indicators) 
When KPI is the active data tab, the Data Table displays statistics from the Profile 
configured by the user. This is useful so the user can display the most important 
information that best suits their needs or application. 

 
KPI Data Tab 
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Key Process Indicators Setup: 
1) Make sure the KPI Data Tab is active. 
2) Click the KPI Setup button above the Sensor Locations descriptions. 

 
The KPI Setup can also be activated by right-clicking a column header. 

 
KPI Setup 

3) Click the desired parameters to display in the Data Table. The parameters are 
grouped by Temperature, Cursor data with slope between, and Time. The user 
can also select to display Range, Average and Standard Deviation rows for each 
of the columns. 

4) When finished select the OK button to display the new settings or Cancel to return 
to the worksheet without making any changes. 

 

A maximum of 12-16 parameter columns can be displayed at one time. 
As columns populate the Data Table, they are automatically sized to fit. 
It is recommended that the most beneficial column information is 
displayed to achieve the best results. 

  



OvenWATCH® Users Guide ♦91♦ 

4.3.7.4 Value Pop-up 
Each value in the Data Table can be displayed as a Value Pop-up. A Value Pop-up is 
graphically illustrated on the Data Graph showing how and where that value was 
extracted from the profile. 

 
Only one Value Pop-up can be displayed on the Data Graph at a time. 

 
Value Pop-up 

To display a Value Pop-up: 
1) Select the Profile worksheet. 
2)  Move the mouse cursor and hover over a desired value in the Data Table. That 

value will automatically be displayed on the Data Graph where that value was 
extracted. 

 
The last displayed Value Pop-up will remain on the Data Graph until the 
user selects a different worksheet. 
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4.3.7.5 Show/Hide Columns 
Data Table parameter columns on the Profile worksheet can be hidden. This is useful 
when an operator wants to focus attention to the most important parameter columns. 

 
Show/Hide Columns 

To display Show/Hide columns: 
1) Select the Profile worksheet. 
2) Right click a parameter column header. 
3) Clear a parameter check box to hide or select to display. 

 

Hidden Parameter columns do not affect the data being collected for that 
parameter. If all Parameter columns are hidden, right-click the Sensor 
locations column header to open the Show/Hide column dialog box. 
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4.3.7.6 Change Summary Stats Settings 
When creating a new workbook, a dialog box appears allowing the user to specify 
Summary Statistics settings based on a Paste Specification or the user selected values.  
 
If the process changes or an operator wishes to perform test experiments, these 
settings can be changed by clicking a parameter column header on the Profile 
worksheet. 

 
Change Summary Stat Settings 

To Change Summary Stats Settings: 
1) Select the Profile worksheet. 
2) Select the Summary Stats tab. 
3) Click the Time Above or Time between column header. 
4) Change the desired Summary Stats settings and select the OK command to 

accept. 
5) Once the new settings have been accepted, the software prompts the user to 

decide if these new settings should be applied to future data run profiles. 
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4.3.7.7 Change Slope Calculator 
Positive and negative slope profile parameter calculator allows the user to calculate 
straight line slopes between any two temperatures. (Default to liquidous and liquidous to 
peak). 
 
If the process changes or an operator wishes to perform test experiments, these 
settings can be changed by clicking a parameter column header on the Profile 
worksheet. 

 
Slope Calculator 

To Change Slope Calculator: 
1) Select the Profile worksheet. 
2) Select the Summary Stats tab. 
3) Click a Peak Slope column header. 
4) Change the desired settings and select the OK command to accept. 
5) Once the new settings have been accepted, the software prompts the user to 

decide if these new settings should be applied to future data run profiles. 
 
  



OvenWATCH® Users Guide ♦95♦ 

4.3.8 Status Bar 
The Status Bar displays the available Help information, X-Y position of the mouse 
pointer, Date and if the AutoM.O.LE.® Mailbox is Local or Remote. 

 
Status Bar Features 
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Help Information: 
When the mouse pointer is placed over a Toolbar button the left side of the Status bar 
will display the action that button performs. 
 
X/Y Readout: 
It is easy to find the exact X and Y-values of any point on the Data Graph using the 
mouse pointer. The X/Y Readout continuously displays the X and Y-axes values of the 
mouse pointer location. 
 
The units displayed for X and Y-values are the same as those displayed on the graph. 
The user can select between °F and °C for the Y-value units. The X-value units can be 
a data point number, time, or distance. Units can be changed on the X and Y-axes at 
any time by selecting the Units command in the Profile menu. 

 
While using the Magnify tool, the X/Y Readout displays the size of the 
selected area of interest.  

 
Other ways to view exact X- and Y-coordinates of a data point is to select 
the Value Tab. 

Date and Time: 
This area of the Status bar displays the current time and date of the PC. 
 

Mailbox Location: 
This area of the Status bar indicates if the AutoM.O.L.E.® Mailbox is located on the 
Local or a Remote computer (Refer to section Read M.O.L.E. Data for more information 
about the Mailbox). 
 
4.3.9 Copy Button 
A Copy Button can be accessed on the Profile worksheet Toolbar. This button copies 
the Profile worksheet to the clipboard so it can be pasted into other applications. 
 

 Copy Button 
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4.4 Watch Worksheet 

The Watch worksheet is where defined product compares real-time data (i.e. “Dynamic” 
Profile) to an established data run (i.e. “Baseline” Profile) and is displayed on the Data 
Graph. 
 
Worksheet features: 
n Menus 
o Status Indicators 
p Watch Control Panel 
q Zone Temperature Legend 
r Sensor Locations 
s Channel Check Boxes 
t Data Graph 
u Data Table 
v Status Bar 

 
Watch Worksheet 
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4.4.1 Menus 

• Menus: File, View, OvenWATCH, Profile, Tools, Window, and Help. 

 
SPC Worksheet Menu Bar and Tool Buttons 
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4.4.2 Status Indicators 
The Status Indicators are activated when the OvenWATCH is recording oven/product 
data and when the M.O.L.E. is inserted into the Station. 

 
Status Indicators. 
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4.4.3 Watch Control Panel 
The Watch Control Panel is where product is defined and selected for quality 
monitoring. 

 
Watch Control Panel 
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4.4.3.1 Product Selection Box 
When a product is ready to run, use the Product Selection Box to select the pre-defined 
product. 

 
Product Selection Box 

The product is defined using the Products command from the OvenWATCH menu and is 
listed alphabetically (refer to section Products for information on defining product). 
 
  



♦102♦ OvenWATCH® Users Guide 

4.4.3.2 Recording Controls 
The OvenWATCH recording controls start and stop the recording process, display the 
elapsed recording time and product in/out information. 

 
Recording Controls 

Recording Controls: 
• Start/Stop Watch: Starts and stops the OvenWATCH recording process. 
• Product Counter: Displays the elapsed time since the start. 
• Product Tracker: A graphic representation of the product position in the oven. 

 
If an board Out sensor is installed, it will be detected automatically by the 
software and an Out counter will appear after the Elapsed Time box. 
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4.4.3.3 Product Identifier 
The Product Identifier is an identification photo of the selected product. This photo can 
be viewed at a larger scale by clicking it. 

 
Photo Identifier 

Using editing tools this photo can be enhanced with the Photo Shop command in the 
Tools menu (refer to section Photo Shop for detailed information). 
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4.4.3.4 Product Controls 
The Product Controls is in essence the command center for defining and reviewing 
recorded product data. 

 
Product Controls 

Product Controls: 
• Products: Defines and edits new and existing product. 
• Alarms: Defines global SPC Alarms for the currently selected product. 
• Playback: Reviews recorded product data. 
• Search: Searches event history for all defined products. 

 
The Product Controls can also be accessed in the OvenWATCH menu (refer to section 
OvenWATCH Menu for detailed information). 
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4.4.4 Zone Temperature Legend 
This legend describes the zone model temperatures that are displayed during the 
recording process. This legend can be viewed on a larger scale by clicking it. 

 
Magnify Map 
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4.4.5 Sensor Locations 
Sensor Locations are descriptions of the location for each sensor labeled in the Data 
Table. The color and description indicates which Data plot on the Data Graph it 
designates. These descriptions are pre-defined when creating the Baseline Profile. 

 
Sensor Descriptions 
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4.4.6 Channel Check Boxes 
The Channel check boxes control whether the associated Data plot is displayed on the 
Data Graph and whether the data for that channel are included in the data table. To 
view or remove a Data plot, click the channel check box beside a sensor location 
description to turn it “ON” or “OFF”. 

 
Channel Check Boxes 
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4.4.7 Data Graph 
The Data Graph is a display where the Baseline and Dynamic Profile for a product is 
overlaid on a graph. 
 
Data Graph features: 
n X and Y-Axes 
o X-axis Scales 
p Autoscaling 
q Baseline Profile 
r Dynamic Profile 
s Process Origin 
t Temperature Reference Lines 
u Zones and Zone Sizes 
v Baseline Setpoints 

 
Data Graph 

 
The Data Graph features are described in the sections that follow. Some of these 
features described are also controlled using the appropriate menu options. Refer to 
section Menu and Tool Commands for more information. 
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4.4.7.1 X and Y-Axes 
The Y-axis (vertical) displays the scale of the measured temperature. Lower values are 
at the bottom and higher values at the top. 
 
The Y-axis includes temperature labels on the left side of the graph. These four 
temperatures divide the vertical axis into four equal parts and are automatically scaled 
to fit the current Y-axis limits. These units can be displayed in Celsius or Fahrenheit 
using the Units command in the Preferences sub-menu on the Watch worksheet.  
 
The X-axis (horizontal) displays values data points collected. The X-axis can be 
converted from data points to time or distance using the Units command in the Profile 
menu.  
 
To see the X-value of any location on the Data Graph, the X/Y Readout in the Status 
bar continuously displays both X and Y-values at the location of the mouse pointer. 
Details of this feature are described in section Status Bar. 
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4.4.7.2. X-axis Scales 
The user can select four different types of X scales for the X-axis. The scales are Point, 
Time – Relative (time measure from process origin), Time – Absolute (Time of day) and 
Distance. To change, select the Units command in the Profile menu.  

 

 

 

 
Scale Types 

 
The Distance scale will not be accurate unless an accurate conveyor 
speed was set in the Baseline Profile. 

 
4.4.7.3 Autoscaling 
The software includes a powerful Autoscaling option to automatically scale the Data 
Graph so the data will always be visible and easy to work with. The software will 
automatically select a range of values for the Y-axes to ensure that all the data fits on 
the screen. The user can change the range of Y-values displayed in Manual mode by 
entering a manual mode using the Scaling command in the Profile menu. 
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4.4.7.4 Baseline Profile 
The Baseline Profile is previously collected data by the M.O.L.E. that represents the 
best profile for a product. The Baseline Profile is used to help calculate values for the 
Dynamic Profile. 

 
Baseline Profile 

A Baseline Profile Data plot represents each of the sensors connected to the M.O.L.E. 
which are different colors that correspond to the color of its sensor location description 
in the Data table. 
 
A Data plot can be hidden or viewed at any time by clicking the check box with the 
corresponding sensor description in the Data table. This allows the user to view any 
combination of the Data plots or individually. 

 

When two or more Data plots overlap the same values, the Data plots 
overwrite each other. For example, if the Data plot that represents the 
sensor connected to channel 5 and channel 1 have the same value, the 
channel 5 Data plot will only appear unless the user suppresses it. 

When printing a Data Graph in black and white, suppressing one or more Data plots is 
useful for clearing a view of a Data plot that is obscured by others near it. 

 

When printing the Data Graph in black and white, the Notes tool can be 
used to help identify each Data plot. 
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4.4.7.5 Dynamic Profile 
When the OvenWATCH is recording data a Dynamic Profile is displayed in the Data 
Graph as dashed Data plots. They represent a predicted profile based on the current 
temperatures of the oven and the Baseline Profile. 

 
Dynamic Profile 

Zone Temperature Compliance 
The Zone Temperature Compliance compares the Baseline Zone temperatures and 
Setpoints with the Actual Zone temperatures and Setpoints.  

 
Zone Temperature Compliance 
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4.4.7.6 Process Origin 
The Process Origin is a gray vertical line at the left edge of the Data Graph indicating 
where the process starts. 

 
The Process Origin is established when the Baseline profile is created 
and is locked on the Watch worksheet. 

 
Process Origin 

When Points or Distance units are being used for the X-values, the X-values to the left 
of the Process Origin are displayed as negative and those to the right as positive. 
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4.4.7.7 Temperature Reference Lines 
Temperature reference lines are colored horizontal lines that are positioned within the 
range of Y-values in the graph. These are derived from the Paste specification of the 
selected product and are automatically displayed. 

 
Temperature Reference lines 

 

In this example, the high Temp Ref line is located at 183ºC and is in Red. 
The low Temp Ref line is at 120ºC and is in Green 
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4.4.7.8 Zones & Zone Sizes 
The X-axis is divided into zones that represent the oven zones in a process that are 
defined in units of length or time. 

 
Zones are established when when the Baseline profile is created and are 
not configurable on the Watch worksheet. 

 
Zones 

Zones are displayed as two colored lines along the bottom of the data graph and as 
dotted vertical lines that extend top to bottom. The first zone begins at the Process 
Origin. 
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4.4.7.9 Baseline Setpoints 
Baseline Setpoints are zone temperatures established for each zone when the Baseline 
profile was created. These temperatures are the settings of heating elements in a 
process. 

 
Baseline Setpoints 

Baseline Setpoints appear in the Data Graph as gray bars at the temperature set for 
each zone. 

 
Zone Temperatures are displayed only after zone sizes are defined in the 
Baseline Profile. 
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4.4.8 Data Table 
The Data Table displays values extracted from the Data plot that can be compared to 
the paste specification parameters for compliance (refer to Appendix D: Parameter 
Definitions for Profile Measures definitions). 

 
Data Table 
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4.4.8.1 Value Pop-Ups 
Each value in the Data Table can be displayed as a Value Pop-up. A Value Pop-up is 
graphically illustrated on the Data Graph showing how and where that value was 
extracted from the profile. 

 
Only one Value Pop-up can be displayed on the Data Graph at a time. 

 
Value Pop-up 

To display a Value Pop-up: 
1) Select the Profile worksheet. 
2)  Move the mouse cursor and hover over a desired value in the Data Table. That 

value will automatically be displayed on the Data Graph where that value was 
extracted. 

 
The last displayed Value Pop-up will remain on the Data Graph until the 
user selects a different worksheet. 
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4.4.8.2 Show/Hide Columns 
Data Table parameter columns on the Profile worksheet can be hidden. This is useful 
when an operator wants to focus attention to the most important parameter columns. 

 
Show/Hide Columns 

To display Show/Hide columns: 
1) Select the Profile worksheet. 
2) Right click a parameter column header. 
3) Clear a parameter check box to hide or select to display. 

 

Hidden Parameter columns do not affect the data being collected for that 
parameter. If all Parameter columns are hidden, right-click the Sensor 
locations column header to open the Show/Hide column dialog box. 
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4.4.9 Status Bar 
The Status Bar displays the available Help information, X-Y position of the mouse 
pointer, Date and if the AutoM.O.LE.® Mailbox is Local or Remote. 

 
Status Bar Features 

Help Information: 
When the mouse pointer is placed over a Toolbar button the left side of the Status bar 
will display the action that button performs. 
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X/Y Readout: 
It is easy to find the exact X and Y-values of any point on the Data Graph using the 
mouse pointer. The X/Y Readout continuously displays the X and Y-axes values of the 
mouse pointer location. 
 
The units displayed for X and Y-values are the same as those displayed on the graph. 
The user can select between °F and °C for the Y-value units. The X-value units can be 
a data point number, time, or distance. Units can be changed on the X and Y-axes at 
any time by selecting the Units command in the Profile menu. 

 
While using the Magnify tool, the X/Y Readout displays the size of the 
selected area of interest.  

 
Other ways to view exact X- and Y-coordinates of a data point is to select 
the Value Tab. 

Date and Time: 
This area of the Status bar displays the current time and date of the PC. 
 

Mailbox Location: 
This area of the Status bar indicates if the AutoM.O.L.E.® Mailbox is located on the 
Local or a Remote computer (Refer to section Standalone Configuration for more 
information about the Mailbox). 
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4.5 Watch SPC Worksheet 

The Watch SPC worksheet extracts the parameter data from each Dynamic Profile and 
displays them in SPC charts. 
 
Watch SPC worksheet features: 
n Menus 
o Status Indicators 
p Watch Control Panel 
q Zone Temperature Legend 
r Profile Measure Tabs 
s X Bar Chart 
t Statistics box 
u Local Alarms 

 
Watch SPC Worksheet 
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4.5.1 Menus 

• Menus: File, View, OvenWATCH, Profile, Tools, Window, and Help. 

 
SPC Worksheet Menu Bar 
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4.5.2 Status Indicators 
The Status Indicators are activated when the OvenWATCH is recording oven/product 
data and when the M.O.L.E. is inserted into the Station. 

 
Status Indicators 
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4.5.3 Watch Control Panel 
The Watch Control Panel is where product is defined and selected for quality 
monitoring. 

 
Watch Control Panel 
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4.5.3.1 Product Selection Box 
When a product is ready to run, use the Product Selection Box to select the pre-defined 
product. 

 
Product Selection Box 

The product is defined using the Products command from the OvenWATCH menu and is 
listed alphabetically (refer to section Products for information on defining product). 
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4.5.3.2 Recording Controls 
The OvenWATCH recording controls start and stop the recording process, display the 
elapsed recording time and product in/out information. 

 
Recording Controls 

Recording Controls: 
• Start/Stop Watch: Starts and stops the OvenWATCH recording process. 
• Product Counter: Displays the elapsed time since the start and the count of 

product that has entered and exited the oven. 
• Product Tracker: A graphic representation of the product position in the oven. 

 
If an board Out sensor is installed, it will be detected automatically by the 
software and an Out counter will appear after the Elapsed Time box. 
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4.5.3.3 Product Identifier 
The Product Identifier is an identification photo of the selected product. This photo can 
be viewed at a larger scale by clicking it. 

 
Photo Identifier 

Using editing tools this photo can be enhanced with the Photo Shop command in the 
Tools menu (refer to section Photo Shop for detailed information). 
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4.5.3.4 Product Controls 
The Product Controls is in essence the command center for defining and reviewing 
recorded product data. 

 
Product Controls 

Product Controls: 
• Products: Defines and edits new and existing product. 
• Alarms: Defines global SPC Alarms for the currently selected product. 
• Playback: Reviews recorded product data. 
• Search: Searches event history for all defined products. 

 
The Product Controls can also be accessed in the OvenWATCH menu (refer to section 
OvenWATCH Menu for detailed information). 
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4.5.4 Zone Temperature Legend 
This legend describes the zone model temperatures that are displayed during the 
recording process. This legend can be viewed on a larger scale by clicking it. 

 
Magnify Map 
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4.5.5 Profile Measures Tabs 
Profile Measure Tabs display predicted parameter SPC data based on the Dynamic 
Profile for each channel. 

 
Profile Measures Tabs 

To display an individual SPC worksheet, use the mouse pointer to click on a tab. The 
worksheet tab will then become highlighted, and the worksheet will now be visible. 

 
The keyboard does not allow access to the worksheets. The only way to 
select the worksheet is by using the mouse pointer. 
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4.5.6 X-Bar Chart 
The X-Bar Chart is a graphical chart produced from Parameter Measures samples. The 
X-bar is the average of the data samples and the UCL and LCL are calculated using a 
formula based on 3s standard deviation. 

 
 X-Bar Charts 

The SPC data points display the value, time & date the data point was recorded when a 
user places the mouse arrow over it.  

 
Data Point Value 

 

Double-clicking an SPC data point will automatically envoke the Playback 
function from that logged point. 
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4.5.7 Local Alarms 
Upper/Lower Specification limits can be set for each individual parameter using the 
Local Alarms pop-up bar. These local alarms can be applied and then activated using 
the Alarms command in the OvenWATCH Menu. Refer to section Alarms for more 
information. 

 
Local Alarms 

To set the alarms, click the check box adjacent to the desired control/spec limit. To use 
the suggested Paste Spec limit values, click the Upper and/or Lower spec command 
buttons. This will auto-populate and check the alarm box for the desired Spec text box. 
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4.5.8 Statistics Box 
The Statistics Box reflects the current SPC data from a parameter. 
 
Statistics box data: 

• N = Number of individual data points (5 max.). 
• Min. = The lowest data point on the graph. 
• Max. = The highest data point on the graph. 
• X-bar = The current X-Bar Bar calculation. 
• Std. Dev. = The Standard Deviation of the selected parameter. 
• Cp; Cpk = Process capability indices (Refer to Appendix B: Statistical Process 

Control (SPC) Background Information). 

 
Statistics Box 
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5.0 Menu and Tool Commands 

 

5.1 File Menu 

Commands in the File menu are used to manipulate and configure workbook files. 

 
The dimmed menu commands are used in other worksheets. 

 

5.1.1 New Workbook 
To start a new workbook: 

1) On the File menu, select New Workbook. A message box appears requesting the 
user select a file folder directory to save the new workbook. The software allows 
only one workbook to be open at a time and if there is an existing workbook open 
it must be closed prior to using this command. 

 

Workbook files are saved with a file extension of (.MOW), and the Profile 
data from the Profile worksheet are saved with an extension of (.MDM). 
These two file types will automatically be saved in the same file folder 
directory because they are inter-dependent on each other and should not 
be separated. 

 
New Workbook List Box 
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After the file location has been determined, a dialog box appears allowing the user to 
specify Summary Statistics settings for the workbook based on a Paste Specification or 
the user selected values. 

 
If you wish to use a Paste Specification proceed to section Paste 
Specification Database for more information. 

 
Summary Statistics Settings 

When a new workbook is created, it uses these values as thresholds for the Summary 
Statistics Data. A table of these values extracted from the profile can be viewed on the 
Summary Stats tab. 
 
The New Workbook command can be accessed on the Toolbars of the Spreadsheet, 
Profile, and Admin worksheets. This command can also be used by pressing [CTRL + 
N]. 
 

 New Workbook Button 
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5.1.1.1 Paste Specification Database 
If the user decides to use one of the Paste Specifications for the Summary Statistics 
use the following procedure. 

 
The Paste database can be accessed using the Paste Selection on the 
Profile menu of the Profile worksheet. 

To select a paste: 
1) On the Summary Stats Settings dialog box, select the Use Paste Specifications 

command button. A dialog box displaying the paste database appears. 

 
Paste Specification Dialog Box 

2) Scroll to and select (highlight) the desired paste specification. 
3) Click the OK command button to accept the selected paste specification, or 

Cancel to return to the Summary Stats Settings dialog box. 

 

If the desired paste is not in the database, the user can add a new one 
using the Paste Wizard. Refer to section Adding a Paste Specification for 
more information. 
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5.1.2 Open Workbook 
The Open Workbook command opens existing workbook files. The software allows only 
one workbook to be open at a time and if there is an existing workbook open it must be 
closed prior to using this command. 
 
To open a workbook file: 

1) On the File menu, select Open Workbook. A list box of workbook files with an 
extension of (.MOW) files appears. 

 
Open Workbook List Box 

2) Highlight the desired workbook file to open by clicking. 
3) Click the Open command button to open, or Cancel to return to the current 

worksheet. 
 

The Open Workbook command can be accessed on the Toolbars of the Spreadsheet 
and Profile worksheets. This command can also be used by pressing [CTRL + O]. 
 

 Open Workbook Button 

 
5.1.3 Close Workbook 
To close a workbook file: 

1) On the File menu, select Close Workbook. If there is a second workbook open, 
closing a workbook will return to the previous workbook. 
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5.1.4 Import 
The Import command imports existing SM.O.L.E. (.bin) GM.O.L.E. (.bin) and SMFW 
(.mdm), files into the Spreadsheet worksheet. This process will copy all documentation 
information (i.e. part, process) from the file being imported, into the user definable cells 
on the Spreadsheet worksheet. 

 
When importing (.MDM) files, they are automatically copied into the 
directory of the current workbook file. 

When importing (*.bin) files they are accompanied by a corresponding hidden *.doc file. 
The file pairs MUST remain together in the same directory while you are importing 
them. If you wish to move some of these files to a new directory before importing, be 
sure to find the matching (*.bin) and (*.doc) files and keep them together. 
 
To import: 

1) On the File menu, select Import and the Import list box appears. 

 
Import List Box 

2) Navigate to the file folder where the file(s) to import are located. (The path and 
file name can also be typed in the File of type text box). 

3) Select the file(s) to import by clicking it once. 
4)  Click the Open command button and the data run will automatically be inserted 

into a data run row on Spreadsheet worksheet.. 
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5.1.5 Save Workbook 
To save a workbook file: 

1) On the File menu, select Save Workbook to save the current workbook file after 
changes have been made. When the user saves the file, all of the current data 
runs and options in the workbook are saved. 

 
The Save Workbook command can be accessed on the Toolbars of the Spreadsheet 
and Admin worksheets. This command can also be used by pressing [CTRL + S]. 
 

 Save Button 

 
5.1.6 Save Workbook As 
To save a workbook file as a different name: 

1) On the File menu, select Save Workbook As to save the current workbook with a 
different file name. When the user saves the file, the current appearance of the 
workbook and the options that have been set are saved. 

 
 Save Workbook As List Box 

The Save Workbook As command can also be used to save selected data runs out of a 
worksheet that includes a large data set. When unwanted data runs are filtered out of a 
large data set and then the Save Workbook As command is used, the selected data 
runs are saved in a new workbook file along with the profile data. 

 
This command is also useful when the user wants to transfer selected 
MDM data run(s) to a floppy disk. 

  



OvenWATCH® Users Guide ♦141♦ 

5.1.7 Save As Text 
To save as text: 

1) On the File menu, select Save As Text to save the Spreadsheet information as a 
text file in the current language, unit of temperature and distance configurations. 
The saved text files have a file extension of (.TXT). This command will save the 
data so it can be opened with software programs that open standard text files. 

 
Save As Text Dialog Box 
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5.1.8 Save as Text Archive 
To save as a text archive: 

1) On the File menu, select Save As Text Archive to save all of the data sets in the 
workbook file as a text archive with a file extension of (.PCA). This is a useful 
way to save large worksheets because text archive files are much smaller than 
saving in workbook file format. This allows saving large workbook spreadsheet 
data in a compressed format. They can be restored using the Load Text Archive 
command. 

 
Save As Text Archive List Box 

5.1.9 Load Text Archive 
To load a text archive: 

1) On the File menu, select Load Text Archive to load a previously saved text 
archive file. This command will clear the currently loaded data and load the 
selected text archive file in its place. 

 
Load Text Archive List Box 

 

To avoid loosing valuable data, it is recommended to load text archive 
files into a new workbook file because as previously stated, this 
command clears all currently loaded data. 
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5.1.10 Preferences 
The Preferences sub-menu lets the user perform custom setup tasks for the software. 

 
Preferences Menu 
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5.1.10.1 Units 
The software can be configured to operate with different units of distance and 
temperature. 

 
This command does not set the units reported by the M.O.L.E., it applies 
only to the software. 

 
To change Units of Temperature or Distance Units: 

1) Select  the Spreadsheet worksheet. 
2) On the File menu, point to Preferences, and then click Units. 
3) Click the option button beside a unit of distance and/or unit of temperature. 
4) Click the OK command button to use the choices as defaults whenever the 

software is started or Cancel to return to the worksheet without making any 
changes.  

 
Units Configuration Window 
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5.1.10.2 Passwords 
Some software commands are password protected for securing access. When a 
command is password protected, the user will not be able to access the command 
without proper password privileges. 
 
The password command works on a global basis. The password currently assigned 
applies to all existing or new workbook files. 
 
To change a password: 

1) Select  the Spreadsheet worksheet. 
2) On the File menu, point to Preferences and then click Passwords. The Password 

protection dialog box appears. 

 
Password Protection Dialog Box 

3) Click the Change Password command button and the Password Change dialog 
box appears. 

 
Change Password Dialog Box. 

 

The software has a default password Admin. When the password is 
changed for the first time, Admin will need to be entered in the “Current 
Password” text box. 

4) Enter current password in the Current Password text box. 
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5) Enter a new password in the New Password text box. 

 
The software only accepts passwords with a minimum of 4 characters. 

• Enter the new password again in the Confirmation text box and then click the OK 
command button to accept or Cancel to not change the password. 

 
5.1.10.3 File Tag Number 
When data is uploaded from the M.O.L.E., the (*.MDM) portion of the data run is 
automatically assigned a special File Tag number. The first two characters are 
automatically assigned OW. The next nine characters are the first nine characters from 
the User/Computer login name and the remaining six characters are in numerical 
sequence that can be specified by the user.  
 
For example, if the User login name is “JSMITH”, a File Tag number would be 
“OW_JSMITH_000100.mdm”. 

 

If there is no User login name available, the software will automatically 
assign the first nine characters from the Computer name (i.e. Production, 
Engineering). If both the User name and Computer name are not available 
“USER” will be assigned to the File Tag number (i.e. 
OW_USER_000100.mdm). 

To change the File Tag number sequence: 
1) Select  the Admin worksheet. 
2) On the File menu, point to Preferences, and then click File Tag Number. 
3) A dialog box appears so a tag file number can be entered in the text box, or the 

number automatically assigned by the software can be used. 

 
File Tag Number Dialog Box 

4) Click the OK command button to set the File Tag Number or click Cancel to close 
the window without changing the number. 

 
If a file tag number is entered that currently exists, the (.MDM) file will be 
incremented automatically to avoid that file from being overwritten. 
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5.1.11 List-Print Data 
The List-Print Data command is used to display the raw data used to graph the Data 
Plots and calculate the statistics. Use this command to display data on the screen or 
create a new file with a file extension of (.PRN) that can be opened with word 
processor, spreadsheet, or database programs. 
 
The table of values that is displayed shows the X-value in the units currently set. The 
Negative X-values in the table indicate those that are to the left of the Process Origin in 
the Data Graph. The next six columns include the Y-value for the channels of data 
collected by the M.O.L.E. in °F or °C, depending on the currently set units. 

 
List Print Data Dialog Box 

All or parts of the data can be List Printed by selecting a limited range of data to print. 
To do this, use the Magnify command from the Tools menu along with the List-Print 
command. Refer to Magnify Tool for details. 
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5.1.12 Page Setup 
The Page Setup command sets page parameters for the Spreadsheet worksheet. 
 
To set page parameters: 

1) On the File menu, select Page Setup and the following dialog box appears. 

 
Page Setup Dialog Box 

2) Select desired parameters to apply to the worksheet. 
3) Click the OK command button to use the current page setup selections. 
4) Click the Cancel command button to leave the page setup command without 

changing anything. 

 

Selections made using the Page Setup command will not be visible on the 
worksheet it is only used for print formatting. To view the selections, use 
the Print Preview command described in Print Preview. 
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5.1.13 Print Options 
The Print Options command is where additional Data Table statistics can be selected to 
be printed along with the Data Graph. Additional documentation can also be selected 
that will be printed on a second page. 
 
To select print options: 

1) On the File menu, select Print Options and the following dialog box appears. 

 
Print Options Dialog Box 

2) Click the check box beside desired Statistic(s) to be printed along with the Main 
Plot. 

3) Click the check box beside desired documentation to be printed on a second 
page. 

• Click the Print command button to close the print options process and initiate 
printing. 

• Click the Print Preview command button to view the report appearance. 
4) Click the OK command button to accept or Cancel command button to leave the 

print options command without making any changes. 
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5.1.14 Page Header / Footer 
The Page Header / Footer command places text on the top and bottom of the printed 
worksheet. 

 

Some of the worksheets contain default information in the Header and 
Footer fields, to view use the Print Preview command. Refer to Print 
Preview for more information. 

 
To add a Header and/or Footer 

1) On the File menu, select Page Header/Footer and the following dialog box 
appears. 

 
Header / Footer Dialog Box 

2) Click the Header tab or the Footer tab. 
3) Determine where to locate the text: left, center or right side of the worksheet. 

Click a text field and type the desired text. 
• The user can also change the text font, distance the note is from the frame edges 

and type of page numbering. 
4) Click the OK command button to accept the Header / Footer or click Cancel to 

return to the worksheet without changes. 

 

The Header / Footer information will not be visible on the worksheet. It is 
only used for printing. To view the Header / Footer information, use the 
Print Preview command. Refer to Print Preview for more information. 
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5.1.15 Print Preview 
The Print Preview command shows a preview of the page(s) to be printed. This 
command is useful when confirming print options. 
 
To view a print preview: 

1) On the File menu, select Print Preview and the Print Preview window appears. 

 
Print Preview Window 

2) Click the Print command button to proceed with printing. 
3) Click the Two-Page command button when there is more than one page in the 

report to view them side by side. 
4) Click the Next Page or Prev Page command button to view other pages of a 

multiple page report. 
5) Click the Zoom In command button to observe small details, and Zoom Out to 

restore. 
6) Click the Close command button to close the Print Preview window. 
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5.1.16 Print 
The Print command prints worksheet information from the workbook. The options that 
appear on the Print dialog box will depend on the type of printer and the installed printer 
driver. 
 
To print a worksheet: 

1) On the File menu, select Print and standard Windows or driver-dependent print 
dialog box appears. 

2) Select desired print options. 

 
Print Dialog Box 

3) Click the OK command button to close the Print dialog box and initiate printing 
the worksheet.  

4) Click the Cancel command button to close the print window without printing. 
 
The Print command can be accessed on all worksheet Toolbars This command can 
also be used by pressing [CTRL + P]. 
 

 Print Button 
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5.1.17 File Viewer 
The File Viewer dialog box displays small thumbnail views of the graphical contents of 
up to 120 (*.MDM) Profiles at one time. 
 
To select a data run:  

1) On the File menu, select File Viewer. 
2) Double click the desired thumbnail graph box and the data run will automatically 

be loaded into the Data graph on the Profile worksheet. 
or 

• Click a desired thumbnail graph box once then select the Open command button. 
This will load the data run into the Data graph on the Profile worksheet. 

 
File Viewer Window 

How the data runs are displayed can be selected by pressing the command buttons on 
the lower end of the dialog box. The user may select command buttons to Alpha Sort (by 
name) or Date Sort (by date profiled). 
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Clicking on a selected graph and then dragging it to another location within the selected 
grid may also arrange the thumbnail graphs. When it is being moved to a new location, 
a dashed box appears around the graph. Changing the arrangement in this manner is 
temporary and the thumbnail graphs will return to the default locations when the dialog 
box is closed. 
 
To change the thumbnail display: 

1) Click the Preferences command button to set the grid arrangement to display from 
2 to 120 graphical files. 

2) Click the appropriate Number of Files option button to make a selection. 

 
File View Dialog Box 

There are two choices to display data runs on Startup. Select the Directory option button 
and all of the profiles in the current workbook file will be displayed. If the Recent option 
button is selected, the last four files saved since the last time the program was exited, 
will be displayed. 
 
There are also two choices on the Sort Order. If the File Name option button is selected, 
all of the files will be sorted by alpha name. If the File Date option button is selected, all 
of the files will be sorted by the date of the data run. 
 
When new selections have been made, use the Set command button to save the 
preferences as default before pressing the OK command button. 
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5.1.18 Report Setup 
The workbook file can be printed in a Report style. Use this command to configure 
which worksheets are to be included. 
 
To setup a report: 

1) On the File menu, select Report Setup and the Report Setup dialog box appears. 

 
Report Setup Dialog Box 

2) Click the check box(es) to enable the worksheet(s) to be printed. 
3) Click the OK command button to accept the selection(s) and return to the 

worksheet, or click Cancel to return to the worksheet without any changes. 
 
5.1.19 Print Report 
To print a report: 

1) On the File menu, select Print Report to print the selected worksheets from the 
Report Setup dialog box as discussed in Report Setup. 
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5.1.20 Send to Mail Recipients 
The Send to Mail Recipients sub-menu commands let the user send a Screen image, 
MDM, or Workbook and associated MDM’s to an email recipient. This command is 
useful when the user would like to share profiles and/or workbooks with other locations 
or when troubleshooting problems. 

 
Preferences Menu 
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To send: 
1) Launch an email program (i.e. Outlook, Firefox, Endora). 
2) Select the desired email command described below: 
• On the File menu, point to Send to Mail Recipients and then select Screen Image to 

capture the current displayed worksheet screen. 

 

When selecting the Screen Image command, the software captures the 
current screen image where the command is activated and converts it 
into a Bitmap (filetag.bmp) file. 

• On the File menu, point to Send to Mail Recipients and then select MDM File to 
send the MDM file from the currently selected data run. 

• On the File menu, point to Send to Mail Recipients and then select Workbook and 
associated MDM’s to send the current Workbook and associated MDM files. 

3) Enter an email address in the email text box and select the OK command button 
to send the file and return to the worksheet where the command was activated. 

 
Enter Recipients 

 
When sending files the email program may display an message dialog 
that informs the user that it is sending the email. 
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5.1.21 Recent Files 1, 2, 3, etc... 
The most recently loaded workbook file names are displayed at the bottom of the File 
menu. To open one of these files, click the name of the desired workbook file or press 
the appropriate number beside it. 
 
5.1.22 Exit 
To exit the program: 

1) On the File menu, select Exit to quit the program. A message box will prompt the 
user to save changes. If the user decides to save the changes, all data and 
configuration changes will be saved with the workbook file. 
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5.2 Edit Menu 

The Edit menu commands enable the user to modify the data set on the Spreadsheet 
and Admin worksheets so the most beneficial data is assembled in the workbook file. 
 
5.2.1 Undo 
To undo a command: 

1) On the Edit menu, select Undo to undo any previous action. For example if the 
filter command is used and then the user decides that command was not 
necessary, the Undo command will restore it back to its original format. 

 
The Undo command can be accessed on the Toolbars of the Spreadsheet and Admin 
worksheets. This command can also be used by pressing [CTRL + Z]. 
 

 Undo Button 

 
5.2.2 Redo 
To redo a command: 

1) On the Edit menu, select Redo to restore the action made by using the Undo 
command. Like Undo, the user can use Redo to restore all of the Undo actions. 

 
The Redo command can be accessed on the Toolbars of the Spreadsheet and Admin 
worksheets. This command can also be used by pressing [CTRL + R]. 
 

 Redo Button 

 
5.2.3 Copy 
To copy data: 

1) Highlight data in a Spreadsheet cell(s) 
2) On the Edit menu, select Copy to copy the data in the selected Spreadsheet cells 

for pasting into other user definable cells or different programs. 
 
This command can also be used by pressing [CTRL +C]. 
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5.2.4 Paste 
To paste data: 

1) Select a user definable cell. 
2) On the Edit menu, select Paste to insert collected data. 

 
This command can also be used by pressing [CTRL +V]. 
 
5.2.5 Remove Row 
To remove a row: 

1) On the Edit menu, select Remove Row to remove a data run row that is not 
wanted. This command is helpful when data has been collected and the user 
feels it is not beneficial to the workbook data set or has a corrupted (*.MDM) file. 

 

This command permanently removes the user configurable data. 
However, the associated (.MDM) file will not be deleted and can be 
retrieved using the Import command. Refer to Import for more 
information. 

 
5.2.6 Hide Row 
To hide a row: 

1) On the Edit menu, select Hide Row to exclude a row without eliminating it 
completely from the workbook file. This command is similar to the filter function, 
and is helpful when data has been collected and it may not be beneficial to the 
data set. To restore hidden data set row(s) click the Red Filter Reset button 
located on the Spreadsheet worksheet. Refer to Filters for more information. 
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5.3 View Menu 

The View menu commands enable the user to manipulate which areas are viewed on 
the worksheet display. 

 
The dimmed menu commands are used in other worksheets. 

 
5.3.1 Toolbar 
To display or hide the toolbar: 

1) On the View menu, select Toolbar to activate or deactivate the toolbar. When the 
Toolbar is deactivated, more of the worksheet area appears on the PC display. 
When there is a checkmark beside the Toolbar command it is activated and 
when the checkmark is not there it is deactivated. 

 
5.3.2 Status Bar 
To display or hide the status bar: 

1) On the View menu, select Status bar to activate or deactivate the Status bar on 
the bottom of the worksheets. When the Status Bar is deactivated, more of the 
worksheet area appears on the PC display. When there is a checkmark beside 
the Status bar command it is activated and when the checkmark is not there it is 
deactivated. 
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5.3.3 Paste Specification 
To view the paste specification: 

1) On the View menu, select Paste Specification to display the paste specification on 
the Data Graph of the Profile worksheet. When the paste specification is 
displayed a check mark appears beside the command on the menu. 

 
Paste Specification 

 

5.3.4 Data Table Tabs 
To display or hide data table tabs: 

1) On the View menu, point to Data Table Tabs select a tab name to display or hide 
the Data Table tabs on the Profile worksheet. When a Data Table tab is 
displayed a check mark appears beside the command on the menu. 
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5.3.5 Zoom In 
To zoom in: 

1) On the View menu, select Zoom In to make the current worksheet view larger. 
The Zoom In command has the capability to zoom in multiple times. When the 
maximum zoom level has been reached the Zoom In command will be dimmed. 

 
The Zoom In command can be accessed on all worksheet Toolbars excluding the 
Profile worksheet. This button will speed up the Zoom In process if multiple zooms are 
desired. 
 

 Zoom In Button 

 
5.3.6 Zoom Out 
To zoom out: 

1) On the View menu, select Zoom Out to make the current worksheet view smaller. 
The Zoom Out command has the capability to zoom out multiple times. When the 
minimum zoom has been reached the Zoom Out command will be dimmed. 

 
The Zoom Out command can be accessed on all worksheet Toolbars excluding the 
Profile worksheet. This button will speed up the Zoom Out process if multiple zooms are 
desired. 
 

 Zoom Out Button 

 

5.3.7 100% 
To zoom to 100%: 

1) On the View menu, select 100% to return the worksheet to its default display size. 
 
The 100% command can be accessed on all worksheet Toolbars excluding the Profile 
worksheet. 
 

 100% Button 
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5.4 Format Menu 

The Format menu includes commands that change the layout or pattern of the text in 
user configurable cells. 
 
5.4.1 Bold 
To make text bold: 

1) On the Format menu, select Bold to turn data in a user configurable cell bold. 
Select the Bold command again to return to standard format. 

 
The Bold command can be accessed on the Toolbar of the Spreadsheet and Admin 
worksheets. 
 

 Bold Button 

 
5.4.2 Italic 
To make text italic: 

1) On the Format menu, select Italic to turn data in a user configurable cell italic. 
Select the Italic command again to return to standard format. 

 
The Italic command can be accessed on the Toolbar of the Spreadsheet and Admin 
worksheets. 
 

 Italic Button 
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5.4.3 Underline 
To underline text: 

1) On the Format menu, select Underline to underline data in a user configurable 
cell. Select the underline command again to return to standard format. 

 
The Underline command can be accessed on the Toolbar of the Spreadsheet and 
Admin worksheets. 
 

 Underline Button 

 
5.4.4 Alignment (Left, Center, Right) 
To align text: 

1) On the Format menu, select Left, Center or Right to align data in a user 
configurable cell. 

 
The alignment commands can be accessed on the Toolbar of the Spreadsheet 
worksheet. 
 

Alignment Buttons (Align Left, Center, and Align Right) 
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5.5 Profile Menu 

The Profile menu includes special commands specifically used on the Profile worksheet. 
Commands in this menu enable the user to view and edit experimental documentation, 
change the appearance of the display and design experiments. 

 
The dimmed menu commands are used in other worksheets. 

 
5.5.1 Part 
Part documentation is information about the part being profiled. There are also fields for 
entering the date the data was recorded, a user name, part number or identification of 
the component being profiled. 
 
To enter Part documentation: 

1) On the Profile menu, select Part. 
2) Enter part documentation. 
3) Click the OK command button accept or Cancel to exit without adding any 

information.  

 
The part date field automatically updates when reading data from the 
M.O.L.E. 

 
Part Dialog Box 
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5.5.2 Process 
To enter process information: 

1) On the Profile menu, select Process to enter and edit information about the 
process that generated the profile data. 

2) Click the OK command button accept or Cancel to exit without adding any 
information.  

 
Process Dialog Box 
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5.5.3 Sensors 
To enter sensor information: 

1) On the Profile menu, select Sensors to enter and edit information about the 
sensor locations that are used to generate the profile data. The Thermocouple 
placement information entered in the T/C-Location cells are also displayed as the 
Sensor Locations in the Data Table. 

 
Sensor Location Descriptions 

2) Select the Location Positions tab to enter sensor location options. The sensor 
location options record the actual physical locations of the sensors, board size 
and appearance information. 

 Location dimensions can also be entered in a number of unit types. Locations 
can be entered by typing in dimensions, or by dragging the sensor locations 
around on the image. Note that X-dimensions are measured from the leading 
(right) edge or the first edge to enter the process, and Y dimensions are from the 
top down. 

3) Click the OK command button accept or Cancel to exit without adding any 
information.  

 

X-dimensions, are also the same dimensions that are used by the 
Channel Lag command to re-align the profile lines if Lag is enabled. Refer 
to Scaling for more information. 
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To select an image: 
1) On the Sensors dialog box, select the Open command button to add or change the 

image file. When this field is activated, a list box appears prompting the user to 
select an image file. The image files supported by the software are Dib-(.dib), Gif 
(.gif), Pcx (.pcx), Tiff (.tif), Targa (.tga), Bitmap (.bmp) and Jpeg (.jpg). 

 
Sensor Location Positions 

2) Click the OK command button to accept the additions/changes or click Cancel to 
return to the Profile worksheet without making any additions/changes. 

 

Once an image (picture) is selected, copy of that image is added to the 
“Images” folder. This enables the user to easily locate any image or logo 
files. 
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To enter a channel lag: 
1) On the Sensors dialog box, select the Channel Lag tab to enter the difference 

between the distance from one sensor to another along a conveyorized system. 

 
Channel Lag dimensions, are also the same dimensions that are used by 
the Location Positions options as X-Dimensions. 

Sensor 
Channel Lag 

2) On the dialog box, CH1 through CH6 represent each channel attached to the 
M.O.L.E. Click an option button beside an unit of measure and then enter the 
distance between sensors. 

 If sensors are placed along a line in a process so they enter and exit oven zones 
at different times, the resulting Data Plots lag behind one another. The software 
uses channel lag information entered here to align the Data Plots so the results 
can be easily compared during analysis. 
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3) To enable the Channel Lag command, click the Show Lag check box. When the 
Channel Lag command is enabled, a small triangle appears on the lower end of 
the process origin line. 

 
Channel Lag Indicator 

4) Click the OK command button to return to the Profile worksheet using the new 
settings or Cancel to return making no changes.  
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5.5.4 Units (X-Axis) 
The Units command is where the unit type for the X-axis is selected. 
 
To select a X axis unit: 

1) On the Profile menu, select Units and the Display Units dialog box appears. 

 
Units Dialog Box 

2) Click the option button beside Point, Time-Relative, Time-Absolute or Distance to 
select the units for the X-axis. 

• Point: the data points collected from the Process-Origin. 
• Time-Relative: Time measured from the Process-Origin 
• Time-Absolute: Time of day 
• Distance: Distance from the Process Origin (Meters, Centimeters, Feet or 

Inches). 
3) Click the option button beside a unit of distance. 
4) Click the Celsius or Fahrenheit option button to represent the degrees for the Y-

axis. 
5) Click the OK command button to return to the Profile worksheet using the new 

settings or Cancel to make no new changes.  
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5.5.5 Scaling 
The Scaling command controls the scale of the X and Y axis units of the Data Graph on 
the Profile worksheet. 
 
To use the scaling command: 

1) On the Profile menu, select Scaling and the scaling dialog box appears. This 
dialog box identifies the current settings of the displayed Y-axis units and the 
maximum and minimum values of the Y-axis. 

2) Select between Auto or Manual mode. In Auto mode, the software selects the 
scale of the Y-Axis to ensure all Data Point values and the highest Zone 
temperature settings are visible in the Data Graph. In Manual mode, the range of 
values for the Y-Axis must be manually set.

 
Scaling Dialog Box 

3) Click the OK command button to use the new settings or Cancel to return to the 
Profile worksheet with no changes. 

 
The Scaling command is not available if the Data Graph has been 
magnified. 
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5.5.6 Temp Ref Lines (Temperature reference lines) 
Temperature reference lines are colored horizontal lines and can be positioned 
anywhere within the range of Y-values in the Data graph on the Profile Worksheet using 
the Temp Ref Lines command in the Profile menu. 

 
Temp Ref Lines Dialog Box 

The Temp Ref Lines dialog box identifies the units of the Y-axis and the current values 
of any Temperature reference lines in the Data graph. Temperature reference lines can 
be added or changed at any time and must be created before the T Above Ref statistic 
will produce valid data in the Data table. 

 

The Temperature reference lines on the Watch worksheet are derived 
from the Paste specification of the selected product and are 
automatically displayed on the Data graph. 

 
To add Temperature Reference Lines to the Data Graph: 

1) On the Profile menu, select Temp Ref Lines. 
2) Click the check box above Low, Med, or Hi to draw that line in the graph. 
3) Enter Y-axis value(s) by adjusting the slider position or typing it in the text box. 
4) Click the OK command to return to the Profile worksheet using the new settings 

or Cancel to not make any changes. 
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5.5.7 Oven Configure 
The Oven Configure command includes options that display details of the experiment 
and establish analysis criteria. These options also enable the user to create a model of 
an ideal process that the software uses to create baseline profiles. 

 
Oven Configure Dialog Box 

The following information describes the options on the Oven Configure dialog box to 
assist the user when configuring an oven. 

 
The software automatically populates the amount of Zones, names and 
lengths. 
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5.5.7.1 Zone Configuration 
The Zone Configuration portion of the Oven Configuration dialog box defines the 
number of zones activated; color, name and length for each desired Zone. 

 

The software automatically populates the the oven settings discussed in 
this section. To enable the ability to configure these settings, refer to 
section General Configuration - Oven Type for more information. 

 
Zone Configuration Options 

When the zones are displayed in the Data Graph, the Zone Slope statistic can be used 
based on the zones defined with this dialog box. The zones can be changed at any time 
by using the cells in this dialog box or changing them in the Zone Matrix. Refer to Zone 
Matrix for more information. 
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To define zones: 
1) On the Profile menu, select Oven Configure. 

 
Oven Configure Dialog Box 

2) Click the corresponding check box beside a zone to activate or deactivate it. 
3) Click the corresponding Color cell to select a custom color for that zone. To 

restore to the default colors click the Default Colors command button. 
4) Click the corresponding Name cell to enter a custom zone name if desired. 
5) Click the option button beside the appropriate units of length or time for the 

process.  
6) Click the corresponding Length cell to enter a specific zone length for each zone. 
7) Click the Show Zones command button to display the zones as colored bars along 

the X-axis. 
8) Click the Zone Temp Matrix check box to activate the Zone Matrix. 
9) Click the OK command button to create the zone(s) and close the Oven Configure 

dialog box or Cancel to quit without making any changes. 
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5.5.7.2 Temperatures 
After zone sizes are defined, the zone temperatures can be set. These temperatures 
could be the upper and lower thresholds of acceptable temperatures to meet process 
standards, temperature settings of upper and lower heat sources, or they could have 
any meaning desired. 

 
 Zone Temperature Section 

To set zone temperatures: 
1) On the Profile menu, select Oven Configure. 
2) Click the top and bottom text field(s) to enter upper and lower zone temperatures 

as a colored line for each zone of the Data Graph. The upper zone temperatures 
appear as solid lines and the lower zones appear as dotted lines. 

 

This matrix can be used to plot predicted data lines based on different 
zone temperatures or conveyor rates. Refer to Prediction Tool for a 
description of this process. 

3). Click the OK command button to create the zone temperatures and close the 
Oven Configure dialog box or click Cancel to quit without making any changes. 
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5.5.7.3 Conveyor speed 
Actual speed of the conveyor can be set using the Conveyor speed portion of the Oven 
Configure dialog box. The software uses this value to calculate the X-axis values when 
a Distance option button has been selected. This number is also used as the actual 
conveyor speed that the software uses when prediction data lines are added. Refer to 
Prediction Tool for more information. 

 
Conveyor Speed Options 

 
Conveyor Speed can not be set or viewed after the Data Graph has been 
magnified. 

To set the conveyor speed: 
1) On the Profile menu, select Oven Configure. 
2) Enter the Conveyor Speed in the text box. This value appears in the Zone Matrix. 
3) Select the option button beside the desired units such as: Distance (inches) per 

Time (Minutes). 
4) Click the OK command button to return to the Data Graph using the new settings 

or Cancel to return to the Data Graph with no changes. 
 



♦180♦ OvenWATCH® Users Guide 

5.5.7.4 Oven Models 
The Oven Configuration dialog box includes an option to select oven model files. This 
command provides a quick way to load oven size and zone temperature information. 

 

The software automatically loads oven configurations. To enable the 
ability to Load & Save oven models, refer to section General 
Configuration - Oven Type for more information. 

To load an Oven Model: 
1) On the Profile menu, select Oven Configure. 

 
Oven Model Commands 

2) Click the Load command button in the Oven Model section and navigate to the 
oven file folder. 

 
Load Oven Model List Box 
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3) Select the desired oven manufacturer file folder. 

 
Oven Model List Box 

4) Select the desired oven model by clicking it once. 
5) Click the Open command button. 

 
Loading an oven model will overlay the current data set with the following information 
from the Oven Model File: 

• Zone Size Information 
• Zone Temperature Information 
• Conveyor Speed Information 
• Process notes if the existing file has process information. 
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Creating and Saving an Oven Model: 
1) Make sure current data is saved. 
2) Edit the following information to fit the desired requirements. Zone Sizes, Zone 

Temperatures, Conveyor Speed (from the Oven Configuration Dialog Box) and 
Part, Process, Sensor Documentation (from the Profile menu). 

3) Select the Oven Configuration command from the Profile menu. 
4) Click the Save command button from the Oven Model section and navigate to the 

Ovens file folder. 
5) Select the file folder of an oven manufacturer. (Additional file folders may be 

created if needed). 
6) Enter the file name in the File name text box. The extension assigned to this file 

is (.OVN). 
7) Click the Save command button. 

The new Oven Model is now ready to use 

 
Process information will only be used if there is no process information 
in the data set that exists when a Oven Model is loaded. 
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5.5.8 Zone Matrix 
To view the Zone Matrix: 

1) On the Profile menu, select Zone Matrix. A check mark appears beside it which 
indicates that the Zone Matrix is activated. When the Zone Matrix is turned “ON”, 
it is located above the Data Graph. 

 
Zone Matrix 

The Zone Matrix command can be accessed on the Profile worksheet Toolbar. 
 

 Zone Matrix Button 
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5.5.9 Paste Selection 
The Paste Selection command displays a selected paste from the database on the Data 
Graph of the Profile worksheet. 
 
To Select a Paste: 

1) On the Profile menu, select Paste Selection. 
2) Select a desired paste from the paste database drop-down list box. 

 

If your paste does not exist in the database, you can create a new one by 
selecting the New command button. Refer to Adding a Paste Wizard for 
more information. 

.  

Paste Specification Dialog Box 
3) Select a Profile Type (Ramp-Soak-Spike or  Ramp-To-Spike). 
4) Click the Apply command button to display the paste specification reference on 

the Data Graph, or Cancel to return to the Profile worksheet without making any 
changes. 

 
To hide the paste spec, you can clear the Paste Spec check mark on the 
View Menu. 
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5.5.9.1 Adding a Paste Specification 
The following section displays the required Paste Wizard Steps to help prepare the user 
prior to creating a new paste. 
 
To add a paste: 

 
Included on the bottom of each Step is a brief guideline of industry 
values related to each specification. 

1) On the Paste Specification database dialog box, select the Add command button. 

 
Paste Specification Dialog Box 

2) Enter the required information and select the Next button. 

 
 Paste Wizard Step 1 
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3) Enter the RAMP – Slope information and select the Next button. 

 
Profile Wizard Step 2 

4) Enter the SOAK –Temperatures information and select the Next button. 

 
Profile Wizard Step 3 
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5) Enter the SOAK –Time information and select the Next button. 

 
Profile Wizard Step 4 

6) Enter the SPIKE – Ramp Slope information and select the Next button. 

 
Profile Wizard Step 5 
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7) Enter the SPIKE – Time Above information and select the Next button. 

 
Profile Wizard Step 6 

8) Enter the SPIKE – Peak Temperature information and select the Next button. 

 
Profile Wizard Step 7 
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9) Enter the SPIKE – Cooling Slope information and select the Finish button to 
create the new paste and return to the Paste Specification database dialog box. 

 
Once the user proceeds to each Step, the Back button can be selected to 
confirm or modify previously entered information. 

 
Profile Wizard Step 8 

10) Scroll down to the bottom of the database and select the new paste specification. 
(Note: all user created paste specifications will always appear on the bottom of 
the database). 

 
Created Paste Selection 

11) Click the OK command button to accept, or Cancel to return to the Summary 
Stats dialog box. 
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5.5.10 Profile Defaults Sub-Menu 
The Profile Defaults sub-menu commands sets Profile menu commands with standard 
defaults. When an option in the Defaults sub-menu is selected and a value is changed, 
the new value becomes the default that is used when a new workbook file is created. 
Default values are applied when importing old data files because they may not contain 
all the information needed by the software. 
 
To create new defaults: 

1) On the Profile menu, point to Defaults, and then select a command. 
2) Change the default setting(s). 
3) Click the SET command button on the specific dialog box to save the new default 

setting(s). 
 
Typically the defaults are set once for specific requirements and cloned afterwards. 
Profile defaults are then changed only when requirements change. 
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5.6 M.O.L.E. Menu 

The M.O.L.E. menu commands configure the M.O.L.E. for collecting experiment data. 

 
The dimmed menu commands are used in other worksheets. 

 

The M.O.L.E. must be inserted in the Station and the proper 
communication port must be configured to properly use the M.O.L.E. 
menu commands. 

 
All M.O.L.E. menu commands cannot be used if the software is currently 
logging oven data. 
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5.6.1 Configuration Wizard 
This wizard guides a user through the communications setup process so the software 
and M.O.L.E. can communicate. Communications configuration needs to be done when 
the software is first installed or PC hardware configurations have changed. 

 
The wizard steps can be accessed individually on the File and M.O.L.E. 
menus. 

 
To configure communications: 

1) Insert the M.O.L.E. into the OvenWATCH Station. 
2) On the M.O.L.E. menu, select Configuration Wizard and the Configuration dialog 

box appears. 

 
Wizard Step 1 – Configuration 

3) Click the option button next to a COM port which the PC is set up for RS-232 
communications or the Auto command button to have the software automatically 
find the COM port the M.O.L.E. is connected. 

4) Click the option button beside the appropriate M.O.L.E. type that will be used to 
collect data, Gold with RF, or Gold. The M.O.L.E. type selection will affect access 
to the RF M.O.L.E. Data command and Receive RF button. It also affects the 
M.O.L.E. configuration parameters, such as number of channels, battery life 
estimate and minimum logging interval. 
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5) Click the OK command button to use the selection and continue to the M.O.L.E. 
Settings dialog box. 

 
The user can exit the Configuration Wizard any time by selecting the 
Cancel button. 

6) Type a company, operator, or machine name in the text box. 

 
Wizard Step 2 – M.O.L.E. Settings 

7) Click the OK command button to store the information in the M.O.L.E. and 
continue to the Configure M.O.L.E. Hardware dialog box. 

8) Click the check box beside a corresponding channel to turn it “ON” or “OFF”. If a 
channel is “OFF”, it does not collect data for that channel, increasing battery life. 

 
Step 3 – Configure M.O.L.E. Hardware 
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9) Enter an interval at which the M.O.L.E. records data points by using the slider(s) 
or manually typing in the corresponding text box. The maximum interval for the 
M.O.L.E. is 23:59:59 hours (one data point per day) and the minimum interval is 
0.2 second (one data point every two-tenths of a second). When using the 
M.O.L.E. with RF Option the minimum interval is 0.5 (one data point every five-
tenths of a second) and when one channel is active, the minimum interval is 0.1 
second (one data point every tenth of a second). 

10) Enter the number of data points the M.O.L.E. will record during the data run. The 
maximum number is dependent on the number of channels turned on. The 
maximum data points the M.O.L.E. can collect are displayed above the text box. 
When the number of data points collected and the recording interval have been 
selected, the software displays the corresponding time the experiment will take 
beside Total Time = text in the lower right corner of the dialog box. 

 

When M.O.L.E. configure options are modified, the data is calculated and 
then amount of profiles the user can expect from the power pack battery 
(based on a fully-charged power pack battery) is displayed in the lower 
right corner next to the Profiles Per Battery line. 
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Optional configurations: 
• Enter a threshold temperature to “trigger” the M.O.L.E. to start recording data by 

using the slider or by entering it in the text box. When any active channel reaches 
that temperature, the M.O.L.E. will begin to record data. This option can trigger 
the profiler when the temperature cools down to the threshold temperature by 
selecting the (-) option button, or heating up to the threshold temperature by 
selecting the (+) option button. If this option is not used for temperature 
triggering, select the Off option button. 

• Enter how many data points to delay “trigger” the M.O.L.E. to start recording data 
by using the slider or by entering it in the text box. The data point entered will 
“trigger” the start of data collection when the specified data point is reached in 
the process. The actual delay is equal to the Interval times the Pts Dly. 

11) Click the OK command button to save the configuration and continue to the Set 
Instruments Clock dialog box. 

12) Enter the correct month, day, year, hour, minute, and second by adjusting the 
slider(s) or manually typing in the corresponding text box. 

 
Wizard Step 4 -Set Instrument Clock 

 
When the Set Instrument Clock dialog box appears the current computer 
clock setting is automatically entered in the text boxes. 

13) Click the OK button to reset the clock. 
 
Configuration is now complete and the M.O.L.E. is ready to collect data. 
 
  



♦196♦ OvenWATCH® Users Guide 

5.6.2 Set M.O.L.E. Clock 
The M.O.L.E. has an internal clock it uses to identify the time and date of each data run 
and to control when each measurement is recorded. The M.O.L.E. clock should be set 
prior to data collection to ensure that the proper time was recorded. 

 
Set M.O.L.E. Clock Dialog Box 

 
To set the M.O.L.E. clock: 

1) Insert the M.O.L.E. into the OvenWATCH Station. 
2) On the M.O.L.E. menu, select Set M.O.L.E. Clock. 
3) Enter the correct month, day, year, hour, minute, and second by adjusting the 

slider(s) or manually typing in the corresponding text box.  

 
When the Set Instrument Clock dialog box appears the current computer 
clock setting is automatically entered in the text boxes. 

4) Click the Send button to reset the clock. 
 
When the setting of the clock is completed, a dialog box with the configuration data 
appears. 
 
To read the M.O.L.E. clock: 

1) Insert the M.O.L.E. into the OvenWATCH Station. 
2) On the M.O.L.E. menu, select Set M.O.L.E. Clock. 
3) Click the Read command button to display the current date and time from the 

M.O.L.E.. If the clock is set wrong, the date or time will be incorrect. 
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5.6.3 M.O.L.E. Settings 
The M.O.L.E. can be configured to store the name of your company, operator or 
machine name. 
 
To select M.O.L.E. settings: 

1) Insert the M.O.L.E. into the OvenWATCH Station. 
2) On the M.O.L.E. menu, select M.O.L.E. Settings. 
3) Type a company, operator, or machine name in the text box. 

 
M.O.L.E. Settings 

4) Click the Send command button to store the information in the M.O.L.E. 
5) When the process is complete, a dialog box appears confirming the information 

sent. Click the OK command button and the Set M.O.L.E. Clock dialog box 
appears for verification of the clock settings. Click the OK command button and 
the software will return to the worksheet. 

 
Using this command may cause the M.O.L.E. to lose any previous data 
collected. 
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5.6.4 M.O.L.E. Configure 
The M.O.L.E. Configure command configures how the M.O.L.E. records data during a 
data run. 

 
M.O.L.E. Configure Dialog Box 

To configure the M.O.L.E.: 
1) Insert the M.O.L.E. into the OvenWATCH Station. 
2) On the M.O.L.E. menu, select M.O.L.E. Configure. 
3) Click the check box beside a corresponding channel to turn it “ON” or “OFF”. If a 

channel is “OFF”, it does not collect data for that channel, increasing battery life. 
4) Enter an interval at which the M.O.L.E. records data points by using the slider(s) 

or manually typing in the corresponding text box. The maximum interval for the 
M.O.L.E. is 23:59:59 hours (one data point per day) and the minimum interval is 
0.2 second (one data point every two-tenths of a second). When using the 
M.O.L.E. with RF Option the minimum interval is 0.5 (one data point every five-
tenths of a second) and when one channel is active, the minimum interval is 0.1 
second (one data point every tenth of a second). 

 
If more than 1 channel enabled, the M.O.L.E. cannot be configured to less 
than a 0.3 second interval. 
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5) Enter the number of data points the M.O.L.E. will record during the data run. The 
maximum number is dependent on the number of channels turned on. The 
maximum data points the M.O.L.E. can collect are displayed above the text box. 
When the number of data points collected and the recording interval have been 
selected, the software displays the corresponding time the experiment will take 
beside Total Time = text in the lower right corner of the dialog box. 

 

When M.O.L.E. configure options are modified, the data is calculated and 
then amount of profiles the user can expect from the power pack battery 
(based on a fully-charged power pack battery) is displayed in the lower 
right corner next to the Profiles Per Battery line. 

Optional configurations: 
• Enter a threshold temperature to “trigger” the M.O.L.E. to start recording data by 

using the slider or by entering it in the text box. When any active channel reaches 
that temperature, the M.O.L.E. will begin to record data. This option can trigger 
the profiler when the temperature cools down to the threshold temperature by 
selecting the (-) option button, or heating up to the threshold temperature by 
selecting the (+) option button. If this option is not used for temperature 
triggering, select the Off option button. 

• Enter how many data points to delay “trigger” the M.O.L.E. to start recording data 
by using the slider or by entering it in the text box. The data point entered will 
“trigger” the start of data collection when the specified data point is reached in 
the process. The actual delay is equal to the Interval times the Pts Dly. 

6) Click the Send command button to send the new configurations to the M.O.L.E.  
7) Click the Read command button to confirm the active configuration. 
8) Click the OK command button to return to the Data Graph, retaining any changes 

made to the configuration or Cancel to return to the Data Graph without recording 
any changes. 

 
The M.O.L.E. configure command can be accessed on the Toolbars of the Spreadsheet 
and Profile worksheets. 

 Configure M.O.L.E.  Button 
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5.6.5 RF M.O.L.E. Data 
This command activates the software to receive “Real-time” data from the M.O.L.E. 
when using it with the RF option. 
 
To Read RF M.O.L.E. Data: 

1) Connect the RF Receiver to the PC using the PC interface cable supplied. 
2) Using the Configuration Wizard, set the COM port and configure the software to 

accept RF M.O.L.E. Data. Refer to Configuration Wizard for more information. 
3) Once the Yes or No command button has been selected, the Read Data from RF 

M.O.L.E. dialog box appears and “Real-time” data is displayed on the lower edge 
of the dialog box. Refer to RF M.O.L.E. dialog box features for more 
information. 

I  
RF Dialog Box 

 

If the computer is not communicating with the receiver, a message box 
appears informing the user of a cable or port configuration problem and 
not the transmitter. If the message does not appear and data is not 
received, refer to the RF Trouble Shooting section in the RF Option 
hardware manual for radio link trouble shooting tips. 
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4) When finished collecting transmitted data, click the OK command button. The 
data run is automatically uploaded into a data run row on Spreadsheet worksheet 
and the Oven dialog box appears. 

 

After the M.O.L.E. has finished sending the profile data, it then reports 
the highest internal temperature logged during the profile. If the highest 
temperature logged is in the range of is 55.0°C-64.9°C the Internal 
Temperature dialog box appears. This indicates the internal temperature 
of the M.O.L.E. has reached the operating temperature warning zone. 

 
Operating Temperature Warning 

 

If the internal temp of the M.O.L.E. is 65.0 C or more the  Internal 
Temperature dialog box appears. This indicates the internal temperature 
of the M.O.L.E. has exceeded the maximum recommended operating 
temperature. 

 
Maximum Recommended Operating Temperature Warning 

 
The software automatically populates the amount of Zones, names and 
lengths. 
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5) Enter the oven conveyor speed and zone temperatures into the oven dialog box. 

 
Oven Settings 
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6) Select a solder paste from the list box and a Profile Type (Ramp-Soak-Spike or 
Ramp-To-Spike). 

 
Select Paste 

7) To complete the download process, select the Apply button to display the data 
run and oven information on the Profile worksheet Data Graph. 

 

When the Data Graph is populated with a new profile, the software 
automatically aligns the X-axis maximum peak values for each Data Plot 
and the oven model so the results can be easily compared during 
analysis. 

 
The RF M.O.L.E. Data command can be accessed on all of the worksheet Toolbars. 

 RF M.O.L.E. Data Button 
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5.6.5.1 RF M.O.L.E. dialog box features 
The RF M.O.L.E. Data dialog box has many features. Use the illustration shown and the 
following definitions to interpret. 

 
RF Dialog Box Features 

n Alarm Message Box: This indicates the last alarm point breached. 
o Internal Temperature Thermometer: This is an indicator displaying the current 

internal temperature of the M.O.L.E.. 
p Remaining Profile Time: This is the amount of data collection time preset by the 

user. 
q Channel Temperatures: This displays the current temperature that the sensors 

are reporting. 
r Elapsed Time: This displays the elapsed time from when the data run has 

begun. 
s Alarm Visual Indicators: When a user-preset temperature has been reached, 

the box of that alarm that has been reached will flash. This feature will be 
dimmed until it has been configured by the user. Refer to RF Alarm Points for 
more information. 

t Alarm Log: This is a drop down list box that logs the time and channel that has 
been breached during the current profile. 
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5.6.5.2 RF Alarm Points 
While transmitting data with the M.O.L.E. RF Option, the RF Alarm Points command 
displays a customized alert message informing the user that a preset temperature has 
been met. 
 
To use RF Alarm Points: 

1) On the M.O.L.E. menu, point to M.O.L.E. “Defaults”, and then select RF Alarm 
Points. 

2) Select alarm(s) to activate, Low, Medium and/or High, by selecting the (+) = 
Rising temperature or (-) = Falling temperature option buttons. 

3) Determine alarm point temperature(s) for the alarm points by adjusting the slider 
or typing in the corresponding text box. 

4) Select which channel to apply the alarm(s) to. 
5) Select a Message box and or an audio indication to alert the user when an alarm 

temperature has been met. 
6) Click the Set command button to set the current configuration as defaults or 

Cancel to keep the previous settings.

 
RF Alarm Dialog Box 

Alarm messages can be changed to indicate what the alarm message is describing. The 
default messages are Low Alarm, Medium Alarm and Hi Alarm.  
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To edit an alarm message: 
1) Click an Edit Message command button. 

 
RF Alarm Message Text Box 

2) Enter custom message in the text box and click the OK command button to 
accept or Cancel to not make any changes. 

 
The results of programming RF Alarm points are used with the RF Option, and appear 
in the Read Data from RF M.O.L.E. dialog box while receiving data. 

 
Alarm Message Box 
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5.6.6 Read M.O.L.E. Data 
This command transfers experiment data from the M.O.L.E. into the software. 
 
To Read M.O.L.E. Data: 

1) Insert the M.O.L.E. into the OvenWATCH Station. 
2) Once uploading has started, the Read Data from M.O.L.E. status box appears 

showing the status of the uploading process. To discontinue click the Cancel 
command button at any time. 

 
Read M.O.L.E. Data Status Box 

 

If a message box appears stating that the M.O.L.E. is not responding, 
check the COM port configuration, cable connections, and/or the M.O.L.E. 
itself (i.e. battery). 
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3) When finished collecting transmitted data, click the OK command button. The 
data run is automatically uploaded into a data run row on Spreadsheet worksheet 
and the Oven dialog box appears.  

 

After the M.O.L.E. has finished sending the profile data, it then reports 
the highest internal temperature logged during the profile. If the highest 
temperature logged is in the range of is 55.0°C-64.9°C the Internal 
Temperature dialog box appears. This indicates the internal temperature 
of the M.O.L.E. has reached the operating temperature warning zone. 

 
Operating Temperature Warning 

 

If the internal temp of the M.O.L.E. is 65.0 C or more the  Internal 
Temperature dialog box appears. This indicates the internal temperature 
of the M.O.L.E. has exceeded the maximum recommended operating 
temperature. 

 
Maximum Recommended Operating Temperature Warning 

 
The software automatically populates the amount of Zones, names and 
lengths. 
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4) Enter the oven conveyor speed and zone temperatures into the oven dialog box. 

 
Oven Settings 
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5) Select a solder paste from the list box and a Profile Type (Ramp-Soak-Spike or 
Ramp-To-Spike). 

 
Select Paste 

6) To complete the download process, select the Apply button to display the data 
run and oven information on the Profile worksheet Data Graph. 

 

When the Data Graph is populated with a new profile, the software 
automatically aligns the X-axis maximum peak values for each Data Plot 
and the oven model so the results can be easily compared during 
analysis. 

 
The Read M.O.L.E. Data command can be accessed on the Toolbars of the Welcome, 
Spreadsheet and Profile worksheets. 

 Read M.O.L.E. Data Button 
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5.6.7 M.O.L.E. Defaults Sub-Menu 
The M.O.L.E. Defaults sub-menu is designed to set M.O.L.E. menu commands with 
standard defaults. When a command in the Defaults sub-menu is selected and a value 
is changed, the new value becomes the default that is used when a new workbook file is 
created. Default values are also used when importing old data files because they may 
not contain all the information needed by the software. 
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5.7 OvenWATCH Menu 

The OvenWATCH menu commands control the product recording process. 

 
The OvenWATCH menu commands are only used on the Watch & Watch 
SPC Worksheets 

 
5.7.1 Start 
The Start command activates the OvenWATCH to start recording oven data. 
 
To Start recording OvenWATCH data: 

1) Insert the M.O.L.E. into the Station. 
2) Select the Start command from the OvenWATCH Menu to start the OvenWATCH 

recording process If either the Yes or No command button was selected the 
recording process will start. 

 
When the OvenWATCH is recording data a Dynamic Profile is displayed in the Data 
graph as dashed Data plots that represents a predicted profile based on the current 
temperatures and the Baseline Profile. (Refer to section Step 1 – Create a Baseline 
Profile for more information). 

 
Recording Data 

The Start command can also be accessed on the Control panel of the Watch and Watch 
SPC worksheets. 
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5.7.2 Stop 
Selecting the Stop command on the OvenWATCH Menu stops the recording process. 
 
The Stop command can also be accessed on the Control panel of the Watch and Watch 
SPC worksheets. 
 
5.7.3 Products 
The Products command is used to define a new or edit an existing product. 
 
To create a Product: 

1) On the OvenWATCH Menu, select the Products command. 

 

The Product commands are password protected and the default software 
password Admin will be needed to gain access to them. If the password 
has been changed, the new password will then be needed. Refer to the 
section Passwords for more information. 

 
Product Definition Palette 
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2) On the the Product Definition palette, select the New command button. Enter a 
product ID, or select the Copy command button to create a new product by 
copying an existing product. 

 

When copying an existing product, the user can select the Show inactive 
Products check box to display all inactive products in the database. 
These products are made inactive using the Modify command. Refer to 
section Modify Product Definition for more information. 

3) Select the Select Profile command button on the Product Definition pallet and the 
software will automatically display the Spreadsheet worksheet where the user 
selects the desired Baseline Profile for the product. 

 
Select Profile 
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4) If the oven is stabilized at the set temperatures, select the Add Probe Temps 
command button to add the current probe temperatures from the oven. 

 
If the oven is not stabilized, you can modify the product ID to add the 
current probe temperatures from the oven once it has stabilized. 

 

If the oven is not stabilized, the user can select the Advanced command 
button on the Product pallet to manually edit the Oven zone temperatures 
from the Baseline Profile. 

 
Advanced Oven Temperature Settings 
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5) Select the Select Paste command button on the Product Definition pallet and the 
Paste Specifications list box appears. 

 
Paste Database Dialog Box 

6) Navigate to the desired paste highlight it, and select the OK command button to 
assign paste specification. 

 

If the user wants to add a new Paste Specification, select the Add 
command button and follow the steps in section Adding a Paste 
Specification for more information. 

7) Select the Select Photo command button from the Product Definition pallet and the 
Photo list box appears. 

8) Navigate to the product photo highlight it, and select the Open command button 
to assign an identification photo. 

 
Image Dialog Box 

 

Once a photo is assigned, the user can use the Photo Shop tools to 
enhance the photo by selecting the Edit Image command button on the 
Product Definition pallet. 
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9) Select the Save command button to save the product definition or Cancel to return 
to the worksheet without creating a product. 

 
Defined Product 

The Product command can also be accessed on the Watch Control panel of the Watch 
and Watch SPC worksheets. 
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To modify a Product definition: 
Once products have been added to the database, the user can modify existing product 
definitions to keep up with process improvements.  

 
Once a product is created, some definitions are locked and cannot be 
modified. 

1) Select the Products command from the OvenWATCH Menu and the Product 
Definition palette appears. 

 
Product Definition Palette 

 

The Product commands are password protected and have a preset 
password Admin. This password will be needed unless it has been 
changed. Refer to the section Passwords for more information. 
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2) Select the Modify command button to select an existing product. 

 
Modify Product Definition command 
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3) Select a product from the Product ID drop-down list. 

 
Modify Product Definition 

• Select the Make Product ID Inactive checkbox to make the selected product 
inactive. 

 
When products are inactive, they will not appear in the Product ID drop-
down list. 

• Select the Show inactive Products check box to display all inactive products in the 
database. 

• Select the Delete Product ID to delete the selected product from the database. 
4) Modify the product definitions to reflect process improvements. 
5) Select the Save command button to save the product definition modifications or 

Cancel to return to the worksheet without changing the product. 
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5.7.4 Alarms 
The Alarms command defines global Alarms for the currently selected product. 
 
The Alarms Table has many features. Use the illustration shown and the following 
definitions to interpret. 

 
Alarms Table Features 

USL/LSL 
These cells contain an Upper or Lower specification limit value. The user can choose to 
populate these with the Paste Specification values or configure them individually by 
double clicking the cell. 

 
Enter Specification limit 

 

These USL/LSL values are linked to the local Alarms set on the Watch 
SPC worksheet. When set from the Alarms Table they will automatically 
update the values on the Watch SPC worksheet. 

 
PV (Present Values) 
These cells contain the PV (Present Value) of parameter. 
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Alarms Specification Limits 
When selected, this enables the USL/LSL Alarms. When USL or LSL cells are 
populated with a spec limit value, the cells are GREEN when the spec limits are not 
violated. If the cells are RED the spec limits have been violated. If a USL or LSL does 
not have a spec limit, they will remain white. 
 
When USL or LSL cells are checked they enable ability to have an Alarm. 
 
The user also has the ability to globally set all of the USL/LSL limits based on the paste 
specification currently selected for the product by pressing the Apply paste spec. values 
command button. 
 
All of the USL/LSL limits can be enabled or disabled at one time by selecting the All On 
or All Off command buttons.  
 
Warnings 
When selected, the software monitors the enabled parameters and warns the operator 
when the parameters are approaching the specification limits. 

 
Warnings can only occur when both the USL and LSL limits have values 
and at least one of the check boxes are enabled. 

If the CpK Lower Limit or % spec Warning Limits are active, a small yellow circle 

appears at the left end of the PV box.  
Warning Indicators 

If CpK Lower Limit or % spec warnings are enabled and the limit(s) are violated, the PV 
cell will be highlighted YELLOW. 
 
  



OvenWATCH® Users Guide ♦223♦ 

Alarms Notification 
When selected, the Alarms – List dialog box and OvenWATCH station will alarm when 
either the USL/LSL and/or Warning values are violated. 

 

If the optional Light tower or SMEMA Interface is installed with the 
system, activating the Alarm Notification will also signal these options. 

If an alarm or warning is triggered during the recording process, the Alarms - List dialog 
box appears. 

 
Alarms-List 

Once the Alarms-List appears selecting the Acknowledge command button stops the 
alarm. Once it has been acknowledged, the operator can then proceed to troubleshoot 
the problem. After the problem has been resolved selecting the Clear command button 
will remove the alarm from the Alarms List. 

 

Acknowledged Alarms will not sound again even if the alarm condition 
persists. Once the alarm condition is cleared, and the same alarm 
condition remains or returns the alarm will be displayed in the Alarm List 
again. 
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External Notification 
Select the check box adjacent to Email and/or Pager options to activate external Alarm 
notification. When either of these options are selected, the associated configuration 
dialog boxes appears. 

 
E-mail Notification Configuration 

 
Pager Notification Configuration 

Enter the appropriate configuration information. You may have to contact your internal 
Information System Manager and your Pager service to get the correct settings. 
 
SMEMA Options 
If your system includes the optional SMEMA interface, select this check box to enable 
the Machine not ready signal. This signal opens whenever there is an Alarm. It closes 
when you either acknowledge or clear an alarm(s). 

 

If a PV parameter is set up to warn the user, the software does not send a 
siginal to the SMEMA option. 
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Barcode 
This is the optional Barcode scanner Alarm setup dialog box. 

 

If the Barcode alarm setup command button is dimmed, it must be 
authorized to prior to use. (Refer to Section Software Authorization for 
additional information) 

 
Barcode Scanner Setup 

 

Each Barcode scanner must be configured using the Barcode 
Configuration dialog box. Refer to section Barcode Configuration for 
more information. 

 
Enable barcode scanner 1 and/or 2 by selecting the associated check box.  
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Incorrect Barcodes: 
Once a barcode is enabled, the user can set the software to alarm, warn, or take no 
action when an incorrect barcode is read and compared to the filter. 
 
If an alarm or warning is triggered during the recording process, the Alarms - List 
appears. 

 
 Alarms-List 

If the Alarms-List appears select the Acknowledge command button to stop the alarm. 
Once it has been acknowledged, the operator can then proceed to troubleshoot the 
problem. If an incorrect barcode is set to alarm, the user can select the Enter value 
command button in the User Notes field to manually add the barcode to the database. 

 

If the incorrect barcode feature is set up to warn the user, the software 
does not allow the ability to update the database with the correct 
barcode. 

 
Enter barcode value 

Once the problem has been resolved selecting the Clear command button will remove 
the alarm from the Alarms List. 

 

Acknowledged Alarms will not sound again even if the alarm condition 
persists. Once the alarm condition is cleared, and the same alarm 
condition remains or returns the alarm will be displayed in the Alarm List 
again. 
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Filter Type: 
A filter can be based on the currently selected product, called the ProductID, a barcode 
range, custom, or none. 
 
For example, the user can select Custom from the Filter Type drop down box and then 
enter a specific Part Number for the software to accept. If the barcode scanner reports 
anything other than that specified part number, the software will take the action 
specified by the user. 

 
Barcode Filter Type 

Filter Type also allows the user to use special characters to enhance the filter 
capabilities.  
  



♦228♦ OvenWATCH® Users Guide 

* = Any single or set of characters at that location in the text. 
? = Any single character at that location in the text. 

 
Barcode Filter Type Special Characters 

 
Once a filter type is specified, the user can test the filter type by selecting the Test 
command button on the Barcode Setup dialog box. 

 
Filter Type Test 

As shown in the Figure above the custom filter is specifying a part number that must 
start with Z46-, will accept any value or set of values, then must have -5 and end with 
any single character. 
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The Figure below shows part number that failed the custom filter due to the fact it stared 
with Y46- which did not match the custom filter that specified the part number must start 
with Z46-. 

 
Failed Custom Filter Type 

Missing barcodes: 
When selected, the software has the ability to alarm, warn, or take no action when a 
missing barcode is reported by the barcode scanner. 

 

The optional Missing barcode detection must be configured using the 
Barcode Configuration command. Refer to section Barcode Configuration 
for more information. 

 
Live data output to file 
When selected, it will cause a .txt text file to be outputted with the same name as the 
barcode. The software will output the text file in the 
ECD\Ovenwatch\liveoutput\directory. 
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Channel Parameter Display 
Mouse over any parameter on the Alarms table and the Statistics box is displayed on 
the Alarms table. Refer to section Statistics Box for more information. 

 
Channel Parameter Display 
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5.7.5 Playback 
The Playback command reviews previously recorded product data. 
 
To review product data: 

1) On the OvenWATCH Menu, select the Playback command. 

 
Playback 

2) Select a product from the Product ID drop-down box. 
3) Select a playback start date and time. 

 

After selecting a Product the user can start the playback process without 
specifying a start date or time. If a start data or time is not specified the 
software wil automatically rewind 24 hours from the displayed date and 
time. 
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4) Select the Play forward or Play back button to start the Playback process. The 
software will search the database for the closest logged data points that match 
the selected product and time. 

 

To locate a specific sample point, the user can single-step forward or 
backward sample points using the single step buttons. 

 

When playing back data, if the specified date and time criteria is before 
the first logged data point for the selected product, the software will 
automatically forward to the first data point logged. If the date and time 
critera is after the last point logged the playback will remain idle. 

5) When the playback process has started a playback label appears in the upper 
right corner of the Data graph. 

 
Playback 

6) To stop the playback process press the stop button (  ) between the play 
forward and play back buttons. 

 
The Playback command can also be accessed on the Control panel of the Watch and 
Watch SPC worksheets.  
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5.7.6 Search 
The Search command searches for event history for all previously defined products. 
 
To search events: 

1) On the OvenWATCH Menu, select the Search command. 

 
Search Dialog Box 
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2) Select any criteria and search will find event to match a product. The user can 
also select a product from the Product ID drop-down list and select desired date 
and time criteria. To search for specific events select a desired event(s) in the 
Filter Events list box and select the Run Query command button. 

 
Search Results 

Once the search is complete the user can select an event and then use the Playback 
command to display it on the Data graph. 

 

To search events for all products select the Run Query command button 
without selecting any search criteria. 

 
The Search command can also be accessed on the Control panel of the Watch and 
Watch SPC worksheets. 
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5.7.7 Configure 
The Configure sub-menu commands contain settings that are used to configure the 
optional Barcode and General Software settings during installation and fine-tuning for 
proper operation.  

 

Because of the sensitive nature of the setting on the Configuration 
commands, they should be used by the Administrator or qualified 
operators only.  

 

The Configuration commands are password protected and has a preset 
password Admin. This password will be needed unless it is changed 
using the Passwords command (for more information refer to section 
Passwords). 
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5.7.7.1 Barcode Configuration 
The OvenWATCH software allows Barcode scanners and a Missing barcode option to 
be added to the system. The software settings are located in the Barcode configuration 
dialog box. These settings are configured when the software and Barcode scanner(s) is 
installed or the computer COM port configurations have changed. 

 

If the Barcode Configuration command is dimmed, it must be authorized to 
prior to use. (Refer to Section Software Authorization for additional 
information) 

Barcode scanner 1 & 2 
This is where the RS-232 communication settings for the Barcode scanners are 
configured to communicate with the computer. 
 
A barcode prefix enables the software to distinguish between two barcode scanners 
connected to the same communication port. Barcode prefixes are stripped off the read 
barcode. Read barcode prefixes that match the specified prefix for that barcode scanner 
are recorded in the database by that scanner number. 

 
The Barcode RS-232 communications will need to be set to match the 
specific communication configurations of the installed barcode scanner. 

 
Barcode Configuration 
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Missing Barcode 
The software has the ability to detect when a Barcode scanner does not report a 
barcode off a product. When this option is checked, the software can be set to alarm. 
 
When the Missing barcode option is enabled, the Missing barcode delay needs to be 
entered. The software will report the time when the missing barcode tracking sensor 
detects the front edge of the product until the barcode scanner reports the barcode. 
Once the Last delay is reported, a time value must be entered in the Missing barcode 
delay box. It is recommended to enter a slightly larger delay number to accommodate 
variable barcode position on the product 

 

If the Missing barcode delay is set too high the product may reach the 
end of the conveyor and the SMEMA interface will no longer be able to 
prevent the product from entering the oven. 

 
Missing Barcode 

 

If the SMEMA option has been installed the Missing barcode detection 
will enable the Machine not ready signal. 
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5.7.7.2 General Configuration 
This section offers brief explanations of the OvenWATCH configuration settings. 

 
Configuration Dialog Box 
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File location boxes 
The top text boxes contain the Database connection string and the optional Remote 
Mailbox location folder path. These settings are automatically configured during 
installation but can be changed depending on optional installation configurations (refer 
to Appendix C: OvenWATCH File Directory Structure for more information). 

 
File Location Boxes 

 
Refer to Appendix C: OvenWATCH File Directory Structure for more 
details on modifying File locations. 
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Sample Trigger Event 
The recording process can be set to be triggered when a board enters the oven or log 
every 30 seconds. 

 
 Sample Trigger Event Settings 
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Sensor Status 
The Sensor status is used for troubleshooting when you want to check if the sensors 
are operational. Each of these buttons will illuminate when the sensor is activated. 

 
Sensor Status 

 
Database Configuration 
This is where the user can select what type of slope measurement they wish to record 
in the database along with the values extracted from the Data plot. (refer to E: Watch 
Profile Measures for Max + and Max - Slope definitions). 
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Conveyor Speed Calibration 
If the user suspects the software is not accurately reflecting the correct conveyor speed, 
it can be calibrated to match the actual speed from the oven mailbox. 
 
To calibrate the conveyor: 

1) Check the Mailbox Conveyor Speed. If you feel this speed accurately reflects the 
actual conveyor speed, select the Calibrate button and the software will start the 
calibration process. 

 

If the oven is not accurately reporting the conveyor speed the user can 
manually enter a conveyor speed. The actual conveyor speed must be 
determined using manual distance/time methods. 

 
Conveyor Speed Calibration 

2) The calibration process takes 1 minute to complete and the software will display 
a counter to the right of the calibration button. When it is complete, the counter 
will display a message informing the user that the calibration has been 
completed. 
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Conveyor Length Adjustment 
If the oven conveyor length is not properly reflected in the Product Tracker, the user can 
manually adjust it using the Conveyor Length Adjust setting to accurately reflect the 
total length of the oven. 
 
The Product Tracker on the Watch control panel reflects the heating and cooling zones 
in the oven based on the zone information from the Baseline Profile. If your oven has 
entry and exit zones you will need to calculate the extra conveyor length and enter that 
value as a percentage. 

 
Conveyor Length Adjust 
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To determine the Conveyor Length Adjust: 
1) Measure the total length of the oven and multiply that value by 100. 
2) Divide the value produced in Step 1 by the length of the heating and cooling 

zones 
3) Subtract 100 from the value produced in Step 2 producing the Conveyor Length 

Adjust value. 
 
Conveyor Length Adjust Formula: 

  
 
For example: 

1) The total length of an oven is 100” so multiply that value by 100 producing a 
value of 10,000. 

2) The length of the heating and cooling zones is 80” so divide the value produced 
in Step 1 (10,000) by 80 producing a value of 125. 

3) Subtract 100 from the value produced in Step 2 (125) producing a Conveyor 
Length Adjust value of 25%. 

 
  

 
CA = TL (100) 

ZL 
-100 
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Standalone Configuration 
Standalone Configuration allows the software to automatically collect the oven settings 
from the remote or oven computer. When activated, it collets the oven settings from the 
oven computer and the Remote Mailbox Location is cleared and disabled. 

 
Standalone Configuration 
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In & Out (I/O) Port settings 
The I/O Port settings are used to set a communication (COM) port so the PC and the 
OvenWATCH components can communicate. These settings are configured when the 
software is first installed but may need to be changed if PC hardware has been 
changed. 

 
I/O Port Settings 
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Additional Password protection: 
The software allows optional commands to be password protected. When any of these 
optional protected commands are activated, the user will not be able to use those 
commands without proper password privileges. 

 

Optional commands are password protected and the default software 
password Admin will be needed to gain access to them. If the password 
has been changed, the new password will then be needed. Refer to the 
section Passwords for more information. 

 
Password Protection 

The password for protected commands work on a global basis. The password currently 
set using the Password command applies to all existing or new workbook files. 
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Oven Type 
This flag can be enabled to allow the user to modify Oven information in Profiles for 
Staged Ovens. Refer to section Oven Configure for more information. 

 
Profile oven Configuration 
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5.7.8 Archive Database 
To save hard drive space or backup the database, the software has a command to 
archive a portion of the database keeping only a desired time period active. 
 
To archive a database: 

1) On the OvenWATCH menu, select Archive and enter the password 

 

The Archive command is password protected and has a preset password 
Admin. This password will be needed unless it has been changed. Refer 
to section Passwords for more information. 

2) Select the how many weeks of the database to keep active. 
3) Select the OK command button to proceed or Cancel to return to the worksheet.

 
Archive Dialog Box 

Once the archive process is complete, the software will store this setting unless the user 
changes it. 

 
The archived portion of the database will not be available for instant 
playback. To review archived data refer to section Restore Archive. 
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5.7.8.1 Restore Archive 
To restore archived database information, the software has a command to load selected 
archived weeks of the database. 
 
To restore from an archived database: 

1) On  the OvenWATCH menu, select Archive and enter the password. 

 

The Archive command is password protected and has a preset password 
Admin. This password will be needed unless it has been changed. Refer 
to the section Passwords for more information. 

2) Select the Restore from archive command button. 

 
Archive Dialog Box 

3) A list box of workbook files with an extension of (.BAT) files appears. Highlight 
the desired file to open by clicking. Each file includes 1 week of data and is 
labeled in the format of (yyyymmdd). 

 
Open List Box 

4) Click the Open command button to open, or Cancel to return to the program. 
 
The data can now be reviewed. Once the user starts recording oven data the archived 
data will automatically be removed from memory. 
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5.7.8.2 Backing up a Database 
Once the database has been archived the data can be backed up into Text files (*.TXT). 
 
To backup a database: 

1) Launch Windows Explorer and navigate to the OWDatabase file folder to display 
the files. 

 
OvenWATCH File Folder 
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2) Double click the ExtractDatabaseToFolder.bat file to activate the backup batch file. 

 
Backup bat file 
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3) Enter a Target Folder to save the backup database files to. 

 
Target Folder 

4) Once this file is activated it will create a series of archive text files in the folder 
specified. 

 
Archive Text Files: 

• AlarmSettings.txt 
• ErrorLog.txt 
• EventHistory.txt 
• Events.txt 
• OvenZoneConfig.txt 
• ProcessChannelEvent.txt 
• Products.txt 
• SampleOvenEvent.txt 
• SampleZoneEvent.txt 

 

If you are planning on un-installing or re-installing the OvenWATCH 
software, it is recommended to move the archived database file folder to 
a different location out of the OvenWATCH file structure. 
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To restore the database backup: 
1) Launch Windows Explorer and navigate to the OWDatabase file folder to display 

the files. 

 
OvenWATCH Database Folder 
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2) Double click the RestoreDatabaseFromFolder.bat file to activate the restore batch 
file. 

 
Restore bat file 
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3) Enter your y to continue the restore process or n to cancel. 

 
This operation will overwrite existing database files. If you want to 
preserve the existing database, it must be moved to a different file folder 

 
Restore Database 

4) Enter the Source Folder to restore the backup database files from. 

 
Target Folder 

 

If the database is to be restored on another machine, the Archive folder, 
and OWImages folder must be copied to the same location on the other 
machine. 
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5.8 Tools Menu 

Tool menu options help the user manipulate and analyze Baseline and Dynamic Profile 
data. 

 
The Tools menu commands are only used on the Profile Worksheet 

  
5.8.1 Magnify Tool 
The Magnify tool enlarges any selected area of the Data Graph for easy visual 
examination. 
 
To Magnify a portion of the Data Graph: 

1) On the Tools menu, select Magnify. 
2) Position the mouse pointer on a corner of the area to enlarge. 
3) Press the left mouse button and drag the pointer diagonally to the opposite 

corner to form a box around the area to be magnified. An outline of the box 
appears as you drag. 

4) Release the left mouse button when the outline of the area to be magnified is 
visible. The area inside the box is then magnified to fill the entire Data Graph. 

 

To show even more detail in the Data Graph, Magnify can be performed 
multiple times. If the Magnify tool reaches the maximum zoom capability 
the software will display a message box informing that the user has 
“Zoomed to Tight”. 
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When using the Magnify tool, the Magnify Map uses a red box to indicate the area 
currently magnified. If the Data Graph was previously magnified, the current level of 
magnification is the red box and previous magnified areas are noted with gray boxes. 

 
Magnify Map 

When the Magnify tool has been used multiple times, click a red box in the Magnify map 
once to go back to a previously selected level of magnification or the white area to 
return to the full view. 
 
• Magnify Applications 
Magnify is useful for visually examining data, when statistics are used. The statistics 
(Value, Time to Ref., T Above Ref, and Statistics) compute only data points that fall 
within the area of the Data Graph. This enables the user to focus the statistical analysis 
on any portion of time, distance, or data point number in the graph. 
 
The Magnify command can be accessed on the Profile worksheet Toolbar. 

 Magnify Button 
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5.8.2 Slope Tool 
The Slope tool finds the average slope between any two points in the Data Graph. 
 
To find the average slope of a line: 

1) On the Tools menu, select Slope. 
2) Position the mouse pointer at a point on the curve.  
3) Press and hold the left mouse button. 
4) Drag the pointer to the end of the desired slope line.  
5) Release the left mouse button when the pointer is at the desired location. The 

software will draw a slope line on the Data Graph, and label the slope value. 

 
Slope Tool 
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To obtain more accurate slopes:  
1) Magnify a portion of the Data Graph using the Magnify tool, and repeat this 

procedure. 
 

To remove a slope line from the Data Graph: 
1) On the Tools menu, select Erase Objects and follow instructions in the Tool status 

box. Refer to Erase Object(s) for more information. 
 
• Slope Applications 
Use the Slope tool to find the average slope between any two points on the graph. 
Longer slope lines tend to produce more accurate slope calculations. 
 
The Slope tool can be used to compare actual data with ideal conditions by drawing a 
line with a known slope (to represent the ideal condition) beside a portion of a Data Plot. 
 
• Slope Limitations 
Slope calculations are based on logged points connected by the slope line. Points occur 
only at the exact time intervals used to record data. 
 
The Slope tool cannot measure slopes when dx (change in X) is equal to zero (when 
the line is vertical). 
 
The Slope tool can be accessed on the Profile worksheet Toolbar. 

 Slope Button 
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5.8.3 Peak Difference Tool 
The Peak Difference tool displays the difference in value between the peak of the 
maximum Data Plot and the peak of the minimum Data Plot in any location of the Data 
Graph. This command is especially useful for measuring side-to-side heating 
differences in ovens.  
 
To display the peak difference between Data Plots: 

1) On the Tools menu, select Peak Difference. 
2) Position the mouse pointer on a corner of the area you want to analyze. 
3) Press the left mouse button and drag the pointer diagonally to the opposite 

corner to form a Peak difference box. An outline of the box appears as you drag. 
 
The peak difference is calculated as the maximum difference between the highest peak 
and the lowest peak within the rectangle. 

 
Peak Difference Tool 

To remove the peak difference: 
1) On the Tools menu, select Erase Objects and follow instructions in the Tool status 

box. Refer to Erase Object(s) for more information. 
 
The Peak Difference tool can be accessed on the Profile worksheet Toolbar. 

 Peak Difference Button 
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5.8.4 Overlay Tool 
The Overlay tool displays a second data run profile over the currently displayed profile 
for comparison. 
 
To compare two Profiles: 

1) On the Tools menu, select Overlay. A list box of data files uploaded into the 
opened workbook appears. 

2) Select a data run file to overlay on the original by clicking it. 
 
The profile will be inserted at the same process origin and automatically scaled to the 
same Y-axis with the Overlaid profile name displayed in the Tool status box. The 
original Data plots remain as solid lines while those added for comparison are dashed. 

 
The dashed “Overlay” Data Plots are the same color as the original Data 
Plots. 

 
Overlay Tool 
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To remove the overlaid Data Graph: 
1) Select the Overlay tool again or press the right mouse button. 

• Overlay Applications 
The Overlay and Magnify tools can be used together to overlay and compare ideal 
reference profiles and magnified portions of the two data files. They can have different 
but overlapping X-values (times, point numbers, logging intervals) or temperatures. 
 
• Overlay Limitations 
If the Data Plots are too numerous to clearly see the information of interest, they can be 
suppressed by removing the check mark from the desired channel in one or both files. 
This must be done to the overlaid profile prior to using the Overlay tool. Save that graph 
and use the Overlay tool again. 
 
The Overlay tool can be accessed on the Profile worksheet Toolbar. 

 Overlay Button 
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5.8.5 Total Heat Tool 
The Total Heat tool computes the area between the Data Plot curves and the bottom 
border of the selected Total Heat area. This can be used for easy evaluation of heat 
input. 
 
Total heat is calculated by multiplying the temperature difference at a given X-value by 
the time between this X-value and the previous one or the area under the curve. The 
units are Degree Seconds. 
 
To evaluate the heat input for a specific portion of a Data Graph: 

1) On the Tools menu, select Total Heat. 
2)  Position the mouse pointer at an initial X/Y coordinate. 
3) Press the left mouse button and drag diagonally. The outline of a box appears as 

you drag. 
4) Release the mouse button when the box reaches the second X/Y coordinate, 

enclosing the range of X/Y values that are included in the total heat calculation. 
 
The area under Data Plot(s) and between the two X-boarders are calculated and 
displayed next to the Total Heat rectangle. The channel that is calculated at 100%, is 
the channel with the highest total heat. The other channels have a calculated total heat 
percentage of the 100% channel. The Data Graph displays the calculated areas by 
filling in the area under the Data Plots. 

 
Total Heat Tool 
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To remove the Total Heat object from the Data Graph: 
1) On the Tools menu, select Erase Objects and follow instructions in the Tool status 

box. Refer to Erase Object(s) for more information. 

 

The bottom of the Total Heat box can be used at either 0° or room 
temperature to give “Total” Heat calculations above 0° or room 
temperature. 

 
• Total Heat Applications 
The Total Heat tool is helpful to compare the heat input between two sensor channels 
and averages the small local temperature differences. This tool is especially useful for 
measuring side-to-side heating differences in ovens. 
 
The Total Heat tool can be accessed on the Profile worksheet Toolbar. 

 Total Heat Button 
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5.8.6 3-DTool 
The 3-D tool draws a 3-dimensional representation of the temperature data. When the 
3-D tool is selected a dialog box appears prompting the user to select a “Normal” or a 
“Reverse-Angle” view. A “Normal” view shows channel 1 in back and channel 6 in front, 
and a “Reverse-Angle” view shows channel 6 in the back and channel 1 in front. 
 
The 3-D profile, shown below, is useful for comparing the general smoothness of the 
Data Plots for each sensor or showing uniform heating across an oven. 

 
 Normal View 

 
Reverse-Angle View 

To remove the 3-D profile: 
1) Click the 3D tool or click the right mouse button. 

 
The 3-D tool can be accessed on the Profile worksheet Toolbar. 

 3-D Button 
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5.8.7 Measure Tool 
The Measure tool is similar to the Slope tool except it measures the distance between 
any two points on the Profile worksheet Data Graph. This tool adds a line labeled with 
the distance values to the graph, and notes the change in X and change in Y (Delta X 
and Delta Y) instead of the slope. 

 
Measure Tool 

To find the distance between two points: 
1) On the Tools menu, select Measure. 
2) Position the mouse pointer at a point on the curve.  
3) Press and hold the left mouse button. 
4) Drag the pointer to the end of the desired point on the curve. 
5) Release the left mouse button when the pointer is at the desired location and a 

slope line labeled with the change in X and Y appears on the Data Graph. 
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To obtain more accurate distances: 
1) Magnify a portion of the Data Graph using the Magnify tool and repeat this 

procedure. 
 
To remove the annotated distance: 

1) On the Tools menu, select Erase Objects and follow instructions in the Tool status 
box. Refer to Erase Object(s) for more information. 

  
The Measure tool can be accessed on the Profile worksheet Toolbar. 

 Measure Button 
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5.8.8 Notes Tool 
The Notes tool adds a leader with text to any portion on the Data Graph to label special 
points of interest. 
 
To add notes to the Data Graph: 

1) On the Tools menu, select Notes. 
2) Position the mouse pointer at the desired location to start the note leader, click 

and drag the mouse pointer to the desired location for the note text and release 
the mouse button. 

3)  A dialog box appears allowing the user to enter a note by typing it in the text box. 
There also are options to customize the color, border and font size of the notes. 

 
Notes Dialog Box 

4)  Click the OK command button or press the [enter] key to finish adding the note. 
 
To remove notes: 

1) On the Tools menu, select Erase Objects and follow instructions in the Tool status 
box. Refer to Erase Object(s) for more information. 

  
The Notes tool can be accessed on the Profile worksheet Toolbar. 

 Notes Button 
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5.8.9 Prediction Tool 
One of the most impressive software features is the Prediction tool. This tool enables 
the user to change a zone temperature value or the conveyor speed and predict the 
outcome of that change. Prediction is easy to use and a valuable command that quickly 
defines process parameters. 
 
To use the Prediction Tool information must first be entered into the Zone Matrix to build 
an accurate “model” of an oven environment. As experience with modeling grows, the 
first values selected may need to be modified accurately reflect the process.  
 
5.8.9.1 Model a Process 
To model a process: 

1) Complete a data run in an oven with a test assembly to establish a Baseline 
Profile for the process.  

 
 Zone Matrix Data 

 
Make sure the zones are visible by clicking the Show Zones check box. 
This enables the user to see how each heating zone affects the results. 
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3) Enter the temperature for each zone by typing it in the temperature cells for each 
zone on the Zone Matrix. This is the set temperature of each zone preset within 
the oven. 

 
If there is a soak zone, then set it to the same temperature as the 
previous zone. 

4) Enter a conveyor speed in the conveyor cell on the Zone Matrix. The conveyor 
rate documented for this experiment is displayed along with zone temperatures.  

 
The units for the X-Cursor should be set to Distance. To set the units to 
distance, select the Units command from the Profile menu. 

5) Move the Process Origin on the Data Graph to the place that corresponds to the 
beginning of the oven. Typically, this is where all of the channel temperatures 
suddenly rise. Now the prediction command is ready to use.  

 
For more information on how to predict results, refer to Predict Results. 
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5.8.9.2 Predict Results 
To predict results: 

 
If Zone temperatures are not set, the Prediction tool will not work. 

1) On the Tools menu, select Prediction and the Oven dialog box appears. The 
dimmed portions of this dialog box indicate that they cannot be modified. 

 
Oven Dialog Box 

2) Enter a hypothetical conveyor speed and zone temperatures or click the Reset 
Temps command button to change zone temperatures back to the original oven 
values. 
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3) Click the Do Prediction command button and the software will calculate and plot 
the predicted outcome based on the changed value(s). The predicted Data plots 
appear on the Data graph as dashed lines. Use the Slope, Measure, and Magnify 
tools to see if the ideal profile has been achieved. 

 

If sensor temperatures inconsistent with zone temperature settings are 
detected, a message box with an explanation appears. The explanation 
appears only once for all zones, each time Prediction is used. After that, 
the software assumes the user is aware of the potential problem. 

 
 Conflicting Conditions Dialog Box 

 

The inconsistent setting does not prevent the software from making a 
prediction. It makes a rational assumption about what is happening. In 
addition to the explanation, several logical ways are displayed to correct 
the conflicting conditions at the bottom of the dialog box. 
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4) Experiment by making more “what if” changes to the conveyor speed and sliding 
Zone Temperature Prediction Handles up or down to the preferred prediction 
temperature. 

 
Dynamic Prediction Feature  

5) Set the oven to the final prediction values, and then perform another data run to 
check if the process has been optimized. 

6) Select the Prediction command again and the original zone temperatures can 
now be reset. Save the current prediction, proceed with another prediction, or 
click the End Prediction command button to remove the predicted Data Plots. 

 
For more information how to save a predicted profile, refer to Saving a 
Predicted Profile. 

The Prediction tool can be accessed on the Profile worksheet Toolbar. 

 Prediction Button 
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5.8.9.3 Saving a Predicted Profile 
To save a predicted profile: 

1) On the Oven Prediction dialog box, click the Save Prediction command button. 
 
The software automatically saves the prediction profile as a new (.MDM) file. The 
predicted profile data is also loaded into the Spreadsheet worksheet as a data run 
labeled with a description, original data run and new File name. 

 
Saved Prediction 
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5.8.10 Tolerance Band Tool 
The Tolerance Band tool develops standard temperature profile bands that can be used 
to determine compliance with required process limits. 
 
To develop a tolerance band: 

1) On the Tools menu, select Tolerance Band and the Tolerance Band dialog box 
appears. 

 
Tolerance Band Dialog Box 

2) Select the check boxes next to the desired channels to apply the tolerance to. 

 
Only active channels will be enabled. 

3) Set the Deg Above with the slider bar or by typing a value in the text box. This 
value is the degrees above the highest selected channel and Deg Below which is 
the degrees below the lowest selected profile channel. 

4) Click the Apply command button and the values for the Tolerance Band are now 
calculated and displayed on the Data Graph. 

5) Click the OK command button to hide the Tolerance Band dialog box and view 
the applied tolerance band. 
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The maximum of the selected channel data values is used and then the Deg Above is 
calculated for the upper value of the band. The lower value is calculated in the same 
manner using the minimum of the channels selected and the Deg below. Once the band 
is defined, a line is drawn from the top to the bottom value at each data point. 

 
Tolerance Band 

6) Click the Remove command button to remove the Tolerance Band from the Data 
Graph. 

7) Click the Cancel command button to return to the Data Graph. 
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Once a Tolerance Band has been developed and applied, it can be saved as a copy for 
future retrieval from the Standards file folder. When the Tolerance band tool is being 
used an existing or previously defined Tolerance Band may be loaded by using the 
Open command button. 
 
To Save a Tolerance band: 

1) On the Tolerance Band dialog box, click the Save command button and a list box 
appears. 

 
Tolerance Band Save List Box 

2) Enter a name in the File name text box. The Tolerance Band will be assigned the 
file name extension (*.STD). 

3) Click the Save command button to save or Cancel to return to the Tolerance Band 
dialog box. 

 
To Open a tolerance band: 

1) On the Tolerance Band dialog box, click the Open command button and a list box 
appears. 

2) Select a Tolerance Band file by clicking it. 
3) Click the Open command button to apply the saved tolerance or Cancel to return 

to the Tolerance Band dialog box. 
 
The Tolerance Band tool can be accessed on the Profile worksheet Toolbar. 

 Tolerance Band Button 
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5.8.11 Erase Object(s) 
The Erase Object(s) command deletes objects and information that have been added to 
the Data Graph. 
 
To erase object(s): 

1) On the Tools menu, select Erase Object(s). 
2) Position the mouse pointer beside the object(s) to erase. 
3) Press the left mouse button and drag diagonally to outline the object(s) to be 

deleted. 
4) A message box asking, “Do you wish to erase this object?” appears for each object 

selected. (The object that the question is referring to will be surrounded by a red 
dashed box). 

5) Click the Yes command button to continue erasing, or the No command button to 
cancel the operation. 

 
If the Erase Objects command is selected and there are no object(s) to be 
deleted, click the right mouse button to escape from that command. 

 
The Erase Object(s) command can be accessed on the Profile worksheet Toolbar. 

 Erase Object(s) Button 
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5.8.12 Erase All 
The Erase All command deletes, in one operation, all the objects and information that 
have been added to the Data Graph. 

 
This operation is not reversable, so use with CAUTION. 

 
To erase all objects: 

1) On the Tools menu, select Erase All. 
2) A message box appears asking, “Do you really want to erase all your objects”. 
3) Click the Yes command button to continue erasing, or the No command button to 

cancel the operation. 

 
If the Erase All command is selected and there are no object(s) to be 
deleted, the erase all command will simply redraw the screen. 

 
The Erase All command can be accessed on the Profile worksheet Toolbar. 

 Erase All Button 

  



OvenWATCH® Users Guide ♦281♦ 

5.8.13 Photo Shop 
The brightness and contrast of a Product identification photo can be edited to enhance 
the quality of the photo. 

 
Editing photos will not change identification photos for existing 
products. The edited photos will only effect new products. 

 
To edit a photo: 

1) On the Tools menu, select Photo Shop and the Photo Shop window appears. 
2) Select the Load button and a list box appears. 
3) Select the desired photo or navigate to the file folder where the file is located. 
4) Highlight the desired workbook file to open by clicking. 
5) Click the Open command button to open, or Cancel to return to the Photo Shop 

window. 

 
Photo Shop Window 

6) Adjust the photo using the Brightness and/or Contrast tools. The photo can also 
be rotated to a better fit in the window. 

7) Click the Save command button to save the changes, or Cancel to return to the 
current workbook. 
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5.9 Navigate Menu 

When viewing a data run on the Profile worksheet, the Navigate menu allows the user 
to view other Profiles without having to select them from the Spreadsheet worksheet. It 
enables the user to view profiles that are one above or below the one currently being 
viewed, or jump to the first or last one uploaded into the open workbook. 
 
Navigate Buttons: 
The Navigate commands can be accessed on the Profile worksheet Toolbar. 

 
 Navigate Tool Buttons 
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5.10 Help Menu 

The Help menu commands are useful when information is needed quickly or when this 
Users guide is not available. 
 
5.10.1 Help 
The Help Index is a complete reference tool that can be used at any time. 
 
To launch the help system: 

1) On the Help menu, select Help to launch the user’s help guide. You may now 
search for the help topic of your choice. 

 
This command can also be used by pressing the [F1] key. 
 
5.10.2 ECD on the Web 
You can access more help by using ECD web commands. Let us help you by using the 
linked commands to the ECD Web site. 

 
ECD Web Sub-Menu 
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5.10.3 About 
To view About information: 

1) On the Help menu, select About M.O.L.E. to display the software version, release 
date and company information. 

 
 About OW SPC Dialog Box 

 
The About command can be accessed on all of the worksheet Toolbars. 
 

 About Button 
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5.10.3.1 Software Authorization 
The software includes an optional software Barcode feature that can be purchased from 
ECD. This option can be activated when the software is authorized with an Activation 
Key. For contact information refer to Section How to Get Additional Help. 
 
To authorize optional Barcode feature: 

1) Start the software program by either double-clicking the OvenWATCH icon or 
selecting it from the ECD OvenWATCH program sub-menu. 

2) On the Help menu, select  About OvenWATCH. 

 
 About Dialog Box 

3) Select the Authorize button on the Help message box and the Authorization 
dialog box appears. 
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4) Enter the information on the Authorization dialog box and supply that information 
to ECD with one of the methods supplied on the dialog box. Once ECD receives 
this information you will be contacted. 

 
Authorization Dialog Box 

5) Upon receiving the Activation Key, enter it into the corresponding text box and 
click the OK command button to authorize. 
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6.0 Service and Troubleshooting 

 

6.1 General Service Information 
 

This section covers maintaining and troubleshooting for the OvenWATCH® System. 

 

The following service and calibration instructions are for use by qualified 
personnel only. Refer to the Operators Safety Information prior to 
performing any service. 
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6.2 Service Troubleshooting 

Decide if the problem is with the M.O.L.E. Hardware, Communications, or Software.  
• If the problem occurs while attempting to log data, the Hardware may be faulty.  
• If the problem occurs while attempting to communicate between SuperM.O.L.E. 

Gold and the PC, the Communications links may be faulty.  
• If the problem occurs while attempting to use a software function, the software 

may be faulty.  
Once it has been determined what item is causing the problem, refer to the appropriate 
service section. Start at the top of the list and work your way down. If the problem is still 
unresolved go to How to Get Additional Help. 
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6.2.1 Hardware Problems 
This section describes basic problems that can occur with the hardware. 
 
Incorrect calibration: 
If the recorded temperatures for all of the Zones are wrong in the same direction (e.g., 
all too high), then possibly the M.O.L.E. has incorrect calibration. Refer to section 
Calibration Information for cautions and procedures, or return the M.O.L.E. to ECD for 
re-calibration. 
 
Wrong or erratic temperature readings: 

1) Check the MUX to Zone Temperature probe connection. 
2) Make sure the M.O.L.E. is fully seated in the Station. 

 
M.O.L.E. doesn’t turn “ON” when after “Starting” to record data:  

1) Make sure the M.O.L.E. is fully seated in the Station. 
2) Clean the Station communication contacts. (Refer to section Cleaning 

Communication Contacts). 
3) Check the logging configuration. If set for board entry the M.O.L.E. will only log 

when board enters the oven. 
 
Internal temperature effects: 
If the M.O.L.E. has been subjected to an internal temperature in excess of the published 
specifications, temperatures outside the specified operating range may cause incorrect 
readings and shorten Power Pack life. Internal temperatures in excess of the 
specified maximum temperature may cause permanent, irreparable damage to 
your Super M.O.L.E. Gold. 
 
Conductive contamination inside the M.O.L.E.: 
Although unlikely, this is known to cause “spikes” (abrupt jumps in value) in the 
recorded temperatures. Other kinds of errors are also possible. 
 
LED stays on steady (no flashing) when power pack is replaced: 
Remove the Power Pack and wait a minute before plugging it in again. If the problem is 
still persists, the start switch is probably damaged. 
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6.2.2 Communications Problems 
This section describes basic problems that can occur with the communication links. 
 
Conflicting use of COM port: 
Perhaps some other software, such as a mouse driver, communications programs, or 
PDA is trying to use the COM port that the Station is configured for.  
 
Serial and/or Parallel PC Interface cables defective: 
Contact ECD to order a replacement cable, refer to section How to Get Additional 
Help for additional product information. 
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6.2.3 Software Problems 
This section describes basic problems that can occur with the software. 
 
“You must place M.O.L.E. in docking station first” error message:  

1) Make sure the M.O.L.E. is fully seated in the Station. 
2) Check the communication links (i.e. the Serial and Parallel PC interface cables). 

 
“M.O.L.E. not responding” error message:  

1) The M.O.L.E. must be programmed with firmware version 9.08 and higher. 
2) Make sure the M.O.L.E. is fully seated in the Station. 
3) Clean the Station communication contacts. (Refer to section Cleaning 

Communication Contacts). 
 
“The database is not responding” error message: 

1) Make sure the SQL software server is running. 
• Activate the SQL Server Service Manager by double-clicking the icon on the 

Notification Area of the windows Taskbar. 
• Select the Start/Continue button. 
• Start the OvenWATCH software. 

 
SQL Server Service Manager 
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6.3 Calibration Information 

Because the SuperM.O.L.E. Gold is made with precision components with high 
temperature stability and tight tolerances; the analog-to-digital converter remains stable 
for years. High quality components together with software algorithms based on the �
IPTS-68 standard for Type K thermocouples have been provided to yield specified 
accuracy and long-term stability. Each unit has been tested at the factory before it is 
shipped. 

 

ECD recommends the M.O.L.E. is factory re-calibrated every 6 months 
when it is being used constantly. If the use is occasional, a period of no 
greater than 12 months between calibrations is recommended. 

Depending on use, however, temperature accuracy should be periodically verified using 
a suitable temperature standard. Any observed inaccuracies are probably not caused by 
calibration error but by any one of a number of other sources, primarily the following: 

1) Poor thermocouple connectors or open thermocouples. 
2) Using a temperature standard that is inaccurate or is not traceable to the 

National Institute of Standards and Technology (NIST, formerly the Nation 
Bureau of Standards). 

• Check the accuracy of your temperature standard and that it is traceable to NIST. 
Be sure that you’re using Type K wire connected to the standard. Be sure that 
your temperature standard is cold-junction compensated, or use an ice point 
reference. 

3) Extremely low Power Pack charge. 
• Recharge the Power Pack. 
4) Sudden changes or excessive ambient temperatures. 
• Allow SuperM.O.L.E. Gold temperature to stabilize for 1/2 hour before calibration. 

If after checking these possible sources of inaccuracy the SuperM.O.L.E. Gold still 
needs to be calibrated, there are two calibration methods: Using a thermocouple 
simulator and another using a voltage reference and an ice point. 

 

Do not attempt to calibrate the M.O.L.E. if you have never used a 
thermocouple simulator, or you are unsure of the accuracy of your 
thermocouple simulator. (Contact ECD for the proper calibration 
procedure P/N A31-0900-05). 

If you need to return the M.O.L.E. for re-calibration, contact ECD and request an RMA 
(Return Merchandise Authorization) to return the M.O.L.E. for service. Refer to section 
How to Get Additional Help for contact information. 
 
 IPTS-68 (International Practical Temperature Scale of 1968) 
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6.4 Changing the Calendar/Clock Battery 

If the clock is resetting itself, it may be necessary to replace the calendar/clock battery. 

 
Changing this battery resets the hardware configuration parameters 
stored in the M.O.L.E. 

 
Change the battery as follows: 

1) Remove the Power Pack battery by separating the unit. This exposes the clock 
battery. 

 
SuperM.O.L.E. Gold calendar/clock battery 

2) Pull the tab to remove the old battery. 
3) Insert a new 3V Lithium battery (ECD P/N #SF30-0041-00), making sure it is 

oriented as pictured on the M.O.L.E. and making sure the tab is tucked in behind 
the battery. 

4) To help prolong clock battery life, the Power Pack battery should be replaced so 
power is not drawing off the Calendar/Clock battery. The Activity LED blinks 
rapidly for two seconds when the Power Pack is first reconnected indicating 
complete reset has occurred. 

5) Start and then stop the M.O.L.E. to clear the memory. 
6) Reconfigure the M.O.L.E.. 

  



♦294♦ OvenWATCH® Users Guide 

6.5 Cleaning Communication Contacts 

Over time the communication contacts on the M.O.L.E. and the station may become 
dirty. To ensure proper communication between the components, it is recommended to 
periodically clean the contacts with a mild mixture of 50%-75% IPA and water. 

 

 

 

Communication Contacts 
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6.6 Barcode Hardware Setup 

This section covers the typical placement and mounting of the required sensor and 
barcodes on an oven conveyor. 
 
The Product Tracking sensor should be placed at the beginning of the conveyor 

 
Barcode Hardware Setup  

Barcode scanner(s) should be placed approx 6” from the Product Tracking sensor. It 
should also be placed as far from the end of the conveyor as possible, allowing the 
conveyor time to react to the optional SMEMA Interface signals. 

 

Test the functionality and adjust the Barcode scanner and Product 
Tracking sensor as necessary. The Product Tracking sensor must detect 
the product before the Barcode scanner(s). 
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6.7 How to Get Additional Help 

If you still have problems, let us help you. We offer many ways to service your 
problems. You can call our Service/Test technicians, visit our web site to view our FAQ 
section (Frequently asked Questions) or send us e-mail explaining your problem in 
detail. 
 
When calling our Service/Test technicians or sending us e-mail, please include the 
following information: 

• Product Description (i.e. SuperM.O.L.E. Gold, OvenWATCH Station). 
• Product Serial Number. 
• Software Version (i.e. 1.12c). 

 
Here is how to contact ECD: 
Telephone: (503) 659-6100 
FAX: (503) 654-4422 
Technical Support: (800) 323-4548 
Email: support@ecd.com 
Internet: http://www.ecd.com 
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Appendix: 

 

A: Specifications 

SuperM.O.L.E.® Gold: 
INPUTS: Up to 6 type K ECD Micro-Thermocouples 

PHYSICAL DIMENSIONS: 3.5" x 6" x 0.37" 

TEMPERATURE MEASUREMENT RANGE: -129°C to +1250°C (200°F to +2282°F) 

INTERNAL OPERATING TEMPERATURE RANGE: 0°C to 65°C (32°F to 150°F) 

Temperatures outside this range may result in inaccurate readings and reduced battery life. 

Absolute Maximum Warranteed Internal 
Temperature: 

82°C (180°F)* SuperM.O.L.E. Gold automatically 
stops monitoring when the internal temperature 
exceeds 80°C (176°F) 

 
WARNING: 

*Exceeding this temperature may permanently 
damage the instrument!  

ACCURACY: Within ± 0.1%+1°C. at –73, 100, 250 and 1000°C. 
Channel to channel compliance within 1°C. 

PROGRAMMABLE SAMPLING PERIOD: 0.1 seconds to 24 hours 

HARDWARE REAL-TIME CLOCK/CALENDER: ±1 minute/month at 25°C 

OPEN THERMOCOUPLE DETECTION. All six channels 

NUMBER OF SAMPLES PER CHANNEL 5460 total for six channels 
 
Power Pack Charger Model Specifications: 
NORTH AMERICA: ECD Part No. E31-0900-25 

Input: 120 V, AC, 50/60 Hz, 2.8 VA Output: 9V DC, 120-200mA, 1.08VA 

CONTINENTAL EUROPE: ECD Part No. E31-0900-21 
Input: 230 V, AC, 50/60 Hz, 2.8 VA Output: 9V DC, 120-200mA, 1.08VA 

 
Station Specifications: 

INPUTS: 6 Male Connectors (Type K) 

PHYSICAL DIMENSIONS: 10.47" x 11" x 1.41" 
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Station Transformer Specifications: 
POWER PACK CHARGE: Typical 50 ten-minute profiles.  

CHARGE TIME: 14 hours.  

EXPECTED POWER PACK LIFE: 300-400 charging cycles.  

OPERATING RANGE: 5.1V to 4.9V (the unit may become unreliable below 
4.5V).  

 
SuperM.O.L.E.® Gold Thermocouple Specifications: 
Thermocouples: Type K, Micro-Connector, Teflon insulated. (Other insulation types available.) 
THERMOCOUPLE RESPONSE TIME 

Wire Size Still Air 
800/100 °F 

60 Ft./Sec. Air 
800/100 °F 

Still H2O 
200/100 °F 

.001 in. 

.005 in. 

.015 in. 

0.05 sec. 
1.0 sec. 
10.0 sec. 

0.004 sec. 
0.08 sec. 
0.80 sec. 

0.002 sec. 
0.04 sec. 
0.40 sec. 

 
Zone Temperature Probe: 
Solid Shell: 

EXTERNAL CONSTRUCTION: Extension cable - SS Overbraid shield. 
Probe - ¼" OD x 0.020 Wall SS tubing. 

INTERNAL CONSTRUCTION: Type K conductors with Magnesium Oxide filler. 

• T/C junctions are electrically isolated from each other, and the SS tube. 
• SS tubing and T/Cs must withstand 325°C continuous 

Flexible: 

EXTERNAL CONSTRUCTION: Extension cable - SS Overbraid shield. 
Probe - SS Overbraid shield. 

INTERNAL CONSTRUCTION Type K conductors w/Fiberglass Sleeving. 

  
Zone Temperature Probe - Limits of error (whichever is greater): 

• Special: 1.1°C or 0.4%. 
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Environmental Limitation Specifications: 
• Altitude up to 2000 meters 
• Maximum relative humidity 80% RH from 0°C to 31°C, decreasing linearly to 17% RH at 50°C. 
• Pollution Degree 2 (Normally only dry pollution, but with temporary conductivity caused by condensation)

Power Pack Charger Only: 
• Mains Voltage Fluctuations + 10% 
• Mains Transient Overvoltage Installation Category II (Per IEC 664) 
• Pollution Degree 2 (Normally only dry pollution, but with temporary conductivity caused by condensation)

NOTE:Tests have shown that because of the sensitive nature of the measurement and logic circuits, the 
following precautions must be observed: 

• Minimize exposure to ESD Events. If the M.O.L.E. or one of the thermocouples receives an 8kV 
electrostatic discharge during the data collection sequence, the M.O.L.E. may switch itself “OFF”. To 
retrieve the data, simply upload the data that was recorded prior to the event. If a new data collection 
sequence is started without uploading first, the existing data stored in the M.O.L.E. will be lost. 

• Keep strong electromagnetic fields away. The thermocouple wires serve as an antenna for 
electromagnetic radiation. If field strength of 3 volts per meter is present (usually due to close proximity 
of radio transmitters) while the M.O.L.E. is collecting data, the accuracy of the data may be 
compromised. This interference is compounded by using long thermocouple wires, as well as the effect 
of the thermocouple wires acting as a “tuned” antenna. 
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B: Statistical Process Control (SPC) Background Information 

This appendix deals with the subset of SPC that is incorporated into software. It does 
not address general SPC principals. A working knowledge of general statistical 
principals and SPC terms is assumed and is not addressed here. There are many good 
basic SPC books such as the DataMyte Handbook where this information may be 
obtained. 
 
Reflow operators, engineers and production managers are expected to understand their 
soldering process so as to deliver quality products cost effectively. This is a continuous 
process. 
 
First, the machine must be checked for consistency. A standard or typical set up should 
be routinely checked prior to any process set point determinations, or actual production 
run machine checks. Only after the machine has been determined to be operating 
correctly and not experiencing abnormal variation, should data from the machine be 
utilized. SPC is all about identifying common or normal variation from abnormal 
variation. 
 
Second, the correct process set points must be determined for a particular product. 
Utilizing the M.O.L.E., the correct set points for a particular product may be determined. 
These set points, if selected correctly and followed, should deliver the maximum 
throughput of quality product. 
 
Third, the machine must consistently deliver the correctly determined set points. SPC 
will help identify common or normal variation from abnormal variation. Checking the 
machine using your M.O.L.E. and the software with its SPC capability will help ensure 
that the machine is consistently performing to its set points and your expectations. 
 
Fourth, repeat the above three steps. Continuous improvement is a never-ending cycle. 
Check the long-term variation of the machine by graphing typical set point samples. 
Using the M.O.L.E., recheck/adjust part number specific set points to maximize your 
quality throughput. Check the machine during a part number run to control the machine 
variation from that part number’s actual ideal set points. 
 
While SPC had its start in high volume repetitive operations, SPC is applicable to many 
other types of operations as well. However, SPC can be difficult to apply to short runs. 
Short runs may be runs that take a long time to process, runs in which multiple samples 
are difficult to collect, and runs where samples are difficult to place into subgroups or 
runs where small quantities are run. 
 
The software charts will be more meaningful to the user if SPC charts are generated 
based on data sets that have the same set points each time. 
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Process Capability 
A process capability index is a standard measure of how a process compares with its 
specification limits—how a process is performing relative to how it is supposed to 
perform. As opposed to the control chart, which shows detailed information about how 
the data compares with control limits, a capability index is a summary of how the data 
compares with the specification limits. 
 
Two common capability indicators are Cp and Cpk.  These values are shown in the 
Statistics Box on each SPC Worksheet.   

 

For both of the index values, the data used to determine them is dictated by the 
subgroup size (N) chosen by the user. In the case where N=1, individual data is used—
for N>1, average data is used (x bar). 
 
The charts on the next page give a graphical representation of the concept of Cp and 
Cpk. Notice that in each graph, the same upper and lower specification limits (USL, 
LSL) are used.  The values of Cp and Cpk will differ according to the data that is 
compared with those specifications. 
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Depending on the particular process being monitored, the desired value for Cp and Cpk 
may differ. In general, however, a Cp and Cpk of 1.33 or above is desired. This assures 
that the process is not only capable of meeting the required specification limits, but also 
has a built-in margin for error that may be needed in special circumstances. In addition 
to targeting a certain minimum Cp and Cpk, it is also desirable to have these two values 
equal one another. This indicates that the process is well-centered between the 
specification limits. 
 

 

Cp ≥ 1.33: Data tightly distributed. 
 
Cpk ≥ 1.33: Data well inside spec 
limits. 

Cp = 1.00: Data fills entire spec 
range. 

 
Cpk = 1.00: Data fills entire spec 
range. 

Cp > 1.00: Data tightly distributed. If 
it were centered between the spec 
limits, no data would lie beyond those 
limits. 
 
Cpk < 1.00: Some data is outside the 
spec limits. 

Cp < 1.00: Data not tightly 
distributed. If it were centered 
between the spec limits, some data 
would still lie outside those limits. 
 
Cpk < 1.00: Some data is outside the 
spec limits. 
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The equations used to calculate the index values are as follows: 

 
 

 
 

 
O
R , whichever is less 

As can be interpreted from the above equations, Cp gives an indication of how narrow 
the data distribution is relative to the width of the specification limits. Essentially, it 
indicates how well the process would be able to stay within the specified limits if the 
data were perfectly centered between those limits. 
 
Cpk compares the widest half of the data distribution to the appropriate specification 
limit.  It indicates whether the process is capable of meeting the specification as 
indicated by the “worst half” of the measurements.  Unlike Cp, the Cpk index measures 
process capability without assuming the data is well-centered. 
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C: OvenWATCH File Directory Structure 

The software uses a variety of executables and support files as listed. The list does not 
include an even larger number of DLL files, which contain executable code that may be 
shared by other programs. 
 
The OvenWATCH program (OW***.EXE) manages four different database like files: 

• The (*.MOW) file, which contains all profiles that you may choose from to use as 
Baseline Profiles for a Product's definition. 

• The DBOvenSQL.ldf & DBOvenSQL.mdf database files, which contains all of the 
Product definitions, data collected from the oven, and the Paste1.PST file, which 
is a library of solder pastes and there specified profiles. 

 
OvenWATCH File Structure 
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As new products are defined or existing product modified, the software uses the 
following files to tie together all the needed information to fully define the product. All the 
information is then stored in the database file (DBOvenSQL.ldf & DBOvenSQL.mdf) in 
the following way: 

1) The Baseline Profile's (*.MDM) file is copied and stored in the database. 
2) The Paste Profile's name is stored in the database. 
3) The Baseline Product's picture (image) is copied and stored the OWImages 

folder and it's name stored in the database. 
 
The illustration below shows the basic file structure and the interrelationship between 
the files when it is installed. 

 
  

 

OvenWatchDB.EXE 

OW100.EXE 

Reflow Solder Machine 

OvenDLL.DLL

SQL Database 
 

DBOvenSQL.ldf 
& 

DBOvenSQL.mdf 

OWImage s

Paste1.PSP 

OWSample.MOW 

BaseLine1.MDM 

*.MDMBaseLine2.MDM

C:\ECD\OvenW AT CH 
OW Database

Picture.JPG 
Assembly.BMP 
etc 

Sample 

OvenWAT CH File Relationship 
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The location may be changed and or the name of any of the following files: 
1) The Remote Mailbox Location. 
2) The OWSample.MOW file and it's related Baseline Profiles, (*.MDM) files and it’s 

directory as follows: 
 
Changing the location of the Remote Mailbox Location: 

1) Start the OvenWATCH program and select the Watch worksheet. 
2) On the OvenWATCH menu, select the Configuration command. 
3) Enter the password (refer to section Passwords for more information). 
4) Click to clear the Standalone check box.  
5) In the Remote Mailbox Location text box, edit the path to match the new network 

path of the remote mailbox folder. 

 
Images Folder Location 
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Changing the name or location of and existing *.MOW file: 
1) Via Windows, navigate to the directory which contains the (*.MOW) workbook 

file, as installed, C:\ECD\OvenWatch\Sample. 
2) Move the folder and the contents to the new directory of your choice. 
3) Start the OvenWATCH program. 
4) If you moved the last opened (*.MOW) workbook file folder, a message box 

appears indicating that it can't find the (*.MOW) workbook file. 

 
Missing File Message Box 

5) On the File menu, select the Open command. The Open list box appears then 
navigate to the new (*.MOW) workbook file location. 

6) Highlight the renamed workbook file to open by clicking and click the Open 
command button. 

 

If a different *.MOW file was moved other than the last opened file, close 
the currently opened (*.MOW) workbook file and open it using the Open 
command on the File menu. 
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D: Parameter Definitions 

 
ValueTab 
 

 
C1, C2, C3, C4 indicate the point, time relative, time absolute, or distance (depending 
on the Units setting) on the X axis where the vertical cursors are set, respectively. The 
values below are the measured values for each channel at that position. 
 
Time To Reference Tab 
 

 
Low, Medium, and Hi are the temperatures set in the Temp Ref Lines dialog, if set. The 
values below these are the times in hours, minutes, and seconds (hh:mm:ss) that it 
takes for each channel to reach the respective reference value starting from the process 
origin. 
 
Time Above Reference Tab 
 

 
Values shown in this tab are taken from the graph at it’s present level of magnification. 
X-axis values outside of view are not included in the calculations. Y-axis values, 
however are included regardless of magnification level. 
 
Low, Medium, and Hi are the temperatures set in the Temp Ref Lines dialog, if set. The 
values below these are the times in hours, minutes, and seconds (hh:mm:ss) that each 
channel spent at or above the reference value, if at all. All time above the reference 
values are accumulated in the total no matter where they occur. 
 
Cure Factor%. The cure factor % is based on the time a sensor temperature was above 
a temperature reference line divided by the time you entered in the Times Above Temp 
(TAT) section of the Temp Ref Lines dialog box. This equation gets more complicated 
as you add more temperature reference lines. The graph illustrates the times used 
(shaded area) to sum the total curing time each temperature threshold contributes. 
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The following equation is used when all three temperature reference lines are used: 

 
Cure Factor % = 100 * ( HItime/HItat + (MEDtime – HItime) /MEDtat + 
(LOtime – MEDtime)/LOtat ) 

The same basic equation is used when there are only two (any two) temperature 
reference lines used: 

 
Cure Factor % = 100 * ( HItime/HItat + (MEDtime – HItime) /MEDtat ) 

or 

 
Cure Factor % = 100 * ( MEDtime/MEDtat + (LOtime – MEDtime) /LOtat ) 

or 

 
Cure Factor % = 100 * ( HItime/HItat + (LOtime – HItime) /LOtat ) 

Finally, if only one temperature reference line is used, the equation is simply: 

 
Cure Factor % = 100 * time/tat  (which ever temp ref line you are using) 

 
  

 

HIref 

LOref 

MEDref 

HI Time

MED Time 

LO Time 



♦310♦ OvenWATCH® Users Guide 

Statistics Tab 

 
Values shown in this tab are taken from the graph at it’s present level of magnification. 
X-axis values outside of view are not included in the calculations. Y-axis values, 
however are included regardless of magnification level. 
 
Minimum is the lowest value measured. The values below are the minimum values for 
each channel. 
 
Minimum X is the point in time where the minimum value occurred. The values below 
are the first point on the X-axis where the minimum value occurred for each channel. 
 
Maximum is the highest value measured. The values below are the maximum values 
for each channel. 
 
Maximum X is the point in time where the maximum value occurred. The values below 
are the first point on the X-axis where the maximum value occurred for each channel. 
 
Average is based on the following equation: 

  

Where n is the number of data points and x is the value of any given data point. The 
values below are the average values for each channel. 
 
Standard Deviation is based on the following equation: 

  

Where n is the number of data points and x is the value of any given data point. The 
values below are the standard deviation values for each channel. Small standard 
deviation means the data is used to calculate it is well centered around the average of 
that same data. 
  

 Σx/n 

 √(n ⋅ Σx2−(Σx) 2)/n ⋅ 
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Zone Slopes 
Zone Slopes tab 

 
Zone 1, Zone 2, Zone3, … are the zones that correspond to the zone parameters 
entered in the Oven Configure dialog box. Up to 30 zones can be represented. The 
values below are the slopes within each zone for each channel using the following 
equation: 

 
(value at end of zone – value at start of zone)/length of zone in time 

Values in bold are the largest values measured for that channel. Slope values are over 
the entire zone and cannot reflect transient changes in temperature within a zone. Large 
zone slopes represent faster heating within a given zone. 

 
  

 

Zone 
1 

Zone 
2 

Zone 
3 

Zone 
4 

value at end 

value at start 
of zone 

length of zone 
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Summary Stats Tab 

 
 Values shown in this tab are taken from the intire graph regardless of its level of 
magnification. 
 
Peak Temperature: 
The largest measured value. Values below are the largest value recorded for that 
channel. The higher the peak temperature, the greater the possibility for component 
damage. 

 
Peak Temp 
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Minimum Temperature: 
The smallest measured value. Values below are the smallest value recorded for that 
channel. Typically, these are the starting values, unless there is active cooling 
employed. It is best if starting temperature values are close to the same. This will allow 
a consistent starting point for other measurements. 

 
Minimum Temp 
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Maximum (+) Slope: 
The largest positive slope measured using a 2% of the total points in the Profile length 
(x-axis) differential. Thus, the equation for slope calculation is as follows: 

 
Slope at point X = (Value at point (X + 10) – Value at point X) / (10 * Log 
interval in seconds) 

 
Max (+) Slope 

The values below are the largest positive slope values calculated for each channel. The 
larger the slope, the faster the temperature is increasing (heating). 
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Maximum (-) Slope: 
The largest negative slope measured using a 2% of the total points in the Profile length 
(x-axis) differential. Thus, the equation for slope calculation is as follows: 

 
Slope at point n = (Value at point (n + 10) – Value at point n) / (10 * Log 
interval in seconds) 

 
Max (-) Slope 

The values below are the largest negative slope values calculated for each channel. 
The larger the slope, the faster the temperature is falling (cooling). 
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Time above Temperature: 
The total time spent at or above the selected liquidous temperature in seconds. This 
time above may occur anywhere along the x-axis and all will be accumulated in the total 
time. Values below are the total times spent at or above for each channel. The longer 
the time, the longer typical solder will be in its liquid state. 

 
Time above 
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Time between Temperatures: 
The time required for the temperature to rise from the begin temperature to the end 
temperature. The values below are the times in seconds measured for each channel. 
The larger this value, the longer it takes to heat the given temperature sense point. 

 
Time between 
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Time above Temperature / Peak Slope:  
The Slope between the point where the profile rise above the liquidous Temperature 
and the Profiles Peak temperature. 

 
Time Above Temp / Peak Slope 
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Peak Slope / Time above Temperature: 
The Slope between the point where the profile drops below the liquidous Temperature 
and the Profiles Peak temperature. 

 
Peak Slope / Time Above Temp 
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KPI (Key Process Indicators) Tab 

 
Values shown in this tab are set by the user. 
 

Temperature Parameters: 
Peak Temperature is the largest measured value. Values below are the largest value 
recorded for that channel. The higher the peak temperature, the greater the possibility 
for component damage. 
 
Min Temperature is the smallest measured value. Values below are the smallest value 
recorded for that channel. Typically, these are the starting values, unless there is active 
cooling employed. It is best if starting temperature values are close to the same. This 
will allow a consistent starting point for other measurements. 
 
Max Slope (+) is the largest slope measured using the seconds specified in the user 
configured calculate slope value text box. This column then displays slopes in the 
positive direction. 
 
Max Slope (-) is the largest slope measured using the seconds specified in the user 
configured calculate slope value text box. This column then displays slopes in the 
negative direction. 
 
Max Slope (+ or -) is the largest slope measured using the seconds specified in the 
user configured calculate slope value text box. This column then displays the largest 
slope in the positive or negative direction depending on which is larger. 
 

X Cursor Parameter Data: 
C1, C2, C3, C4 indicate the point, time relative, time absolute, or distance (depending 
on the Units setting) on the X axis where the vertical cursors are set, respectively. The 
values below are the measured values for each channel at that position. 
Slope between Cursor locations is the straight line slope between any two cursors. 
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Time Parameter Data: 
Time To Temperature is the time that it takes for each channel to reach the selected 
value in seconds or minutes. 
 
Time above Temperature is the total time spent at or above the selected temperature 
in seconds or minutes. 

• Total (+/-): Total Time above temperature. 
• Rising (+): Time above during the rising portion of the temperature Profile. 
• Falling (-): Time above during the falling portion of the temperature Profile. 

 
Time between Temperatures is the time required for the temperature to rise from the 
begin temperature to the end temperature in seconds or minutes. 
 
Slope between Temperatures is the straight line slope measured between the 
beginning and ending temperatures. 
 

Display Values: 
Range is the difference between the largest and smallest value recorded or calculated 
for each column of data. The smaller the range, the smaller the spread between the 
values collected from each channel. 
 
Average is the calculation of the average value for each column displayed. 
 
Standard Deviation is the calculation of the Standard Deviation for each column 
displayed. 
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E: Watch Profile Measures 

Ramp (slope): 
The straight-line slope in degrees per second measured from the intersection of the 
Process Origin and the Temperature of each channel to the Temp where the profile 
each channel reaches the Soak Begin Temp. Profiles that do not reach the Soak Begin 
Temp report a Ramp of 0. 

 
Ramp 
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Soak (time): 
The number of profile temperature values that fall between Soak Begin Temp and Soak 
End Temp Times the log interval. Profiles that do not reach the Soak Begin Temp report 
a Soak of 0. 

 
Soak 
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Spike (slope): 
The straight line slope in degrees per second measured from where the profile reaches 
the Soak End Temp to where the profile reaches a Peak temperature value. Profiles 
that do not go above the Soak End Temp report a Spike of 0. 

 
Spike 
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Peak (temp): 
The first maximum temperature value after the Process Origin. 

 
Peak 
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Time Above: 
The number of profile temperature values that are above the Liquidous Temp times the 
log interval. Profiles that do not go above the Liquidous Temp report Time Above as 0. 

 
Time Above 
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Max + Slope: 
The largest positive slope in degrees per second detected from the Process Origin to 
the end of the last Zone as measured using the change in temperature divided by 2% of 
the total number of logged points multiplied by the log interval. 

 
Max + Slope 
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Max - Slope: 
The most negative slope in degrees per second detected from the Peak down to 150°C 
[302°F] as measured using the change in temperature divided by 2% of the total 
number of logged points times the log interval. 

 
Max - Slope 
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F: Pull Down Menus & Toolbar Buttons 

 
The dimmed menu commands are used in other worksheets. 

Active menus for the Welcome, SMG Data Worksheets & Guide Worksheets: 

 

Active menus for the Spreadsheet Worksheet 

 

Active menus for the Profile Worksheet: 



♦330♦ OvenWATCH® Users Guide 

Active menus for the Admin Worksheet: 

 

Active menus for the SPC Worksheet(s): 
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Toolbar buttons: 

 3d View Notes 

 About Open 

 Align Left  Overlay 

 Align Right  Peak Difference 

 Back (To Previous Data Run) Prediction 

 Bold Print 

 Center Read M.O.L.E. Data 

 Configure M.O.L.E Receive RF 

 Context Help  Redo 

 Copy Save 

 Erase All Slope 

 Erase Objects Total Heat  

 First (Data Run) Tolerance Band 

 Italic Underline 

 Last (Data Run) Undo 

 Magnify Zone Matrix 

 Measure Zoom 100% 

 New Zoom In 

 Next (Data Run) Zoom Out 
 




